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Itorductio]

The Ministry of Education exerts no efforts to provide schools
with computer sets. Therefore, computer experts are doing their
best to prepare the most suitable books for all stages. This book
made experience learning easy and helps the students teach
themselves.This book concentrates on (Word). Keyboarding
should be taught in the early grades before students
acquire bad habits. The items covered in this book will enable
the pupils create and publish great-looking documents quickly and
easily and in a very smart way.

It is often pointed out that computers, like hammers, saws or
washing machines, are just tools. We use computers in our
everyday life for tasks such as writing documents; calculate
budgets, or any kind of ‘slave’-labor that the computer can help us
with. "The greatest advantage of using computers in schools is that
it can be used as a tool for arriving at solutions, wherever
appropriate." Software shows us that a majority of the programs
are directed at helping the kids memorize facts, foreign words,
laws of physics, or to simulate conditions and situations. In more
recent times - with the boost of Internet - a heavy focus on search
and downloading of information is seen.

It often seems like information is not good enough, if it has not
presented multi-medially on the screen, or loaded from a CD or
Internet. There is nothing wrong with the fact that information is
retrieved by the use of computers or distributed via hi-tech media -
but is this media, this path of transportation, so significant that
schools and families at any cost must leap at this magic
technology and use it - the sooner the better? . Shortage of
information is not a major problem today; the contrary seems to be
the case; to limit the flood of information.

Computer programs are often consciously used today to
increase the student's interest for a subject. "From now on the kids
will like math ....because solving problems is just like playing a
game", as the ad for a math training software product, promises.
By using this software, the teacher can make the lessons "as
exciting as Space Invaders from Mars", because the students will
be able to "practice trial-and-error all on their own and thereby find



the right answers to all the problems". Furthermore, the
programme is "easy to use and requires no special computer
knowledge from the teacher”. In this way, one can "give new life to
math education”.

We are reminded that the computer is not an ordinary tool, such
as typewriter or a saw, by the fact that they exert such a great
fascination on youths (especially younger boys), or millions of
processes are carried out in a split second, with the most amazing
results, without enabling us to experience the cause and effect:

In real life, computers are usually connected to the ‘outside world’
in one way or another: They measure and control things, reads bar
codes, transfer money from one bank to another, etc.

We must encourage the young person’s universal development, in
which the basic understanding of computer technology is one. Showering
the modern school kids with loads of ‘micro’, *‘Mega’, ‘Giga’,
‘Multimedia’, ‘click-and-learn-programs’ that make all problems in the
world into a "game", and as exciting as playing "Space Invaders from
Mars".
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Chapter (1)

Computers in everyday life
Objectives:
By the end of this chapter, you will be able to:

Define the situations where a computer

might be more appropriate than people

Define the situations where people
might be more appropriate than a computer.

Give real world examples.




Introduction:

| I[dentify some situations where a computer is
more appropriate than a person for carrying out a
task and where itis not.

B Know some of the uses of large-scale computer

applications in business.

B Know some of the uses of large-scale computer
applications in government.

¥ Know some of the uses of large-scale computer
applications in hospitals/healthcare.

BKnow some of the uses of computer
applications in education.
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Computers in everyday life:

Computers are in common use today as they can
be used to process large amount of data in a short
time. Many areas of modern society take advantage
ofthe power of computing.

Identify some situations where a computer is

more appropriate than a person for carrying

out a task and where itis not.
@

Where Computers are better?

ye tasks:
etitive sks.
= Rep! automated‘a \ations:
2 pasily atical calcl
N s situations:

Where People arﬁ- better?

¥ Any activity re
Creativity,

quiring thought oy

Interacting With humang

The Computer




Many people have a PC. at home,
either for work or entertainment.
Some of the common uses for a

PC. are:

@ Working from home.

@ Managing your finances,

kY .
ﬁ&. Word processing. [
@ Time management, to sort or arrange meetings,
birthdays, arrangements etc...

@ Sending messages to others by email.

@ Browsing for information, news or shopping on
the internet.

@ Watching, listening and reading films, songs,
music and books.

@ Learning languages or any other aspects of
knowledge.

@ Playing computer games.



administration, communication, to sell products (online
develop software and support services.

Offices::
Companies can use computers to store their
records, keep track of what used to pay
employees, send out letters to customers, and
communicate with other companies and/or

department.

Shops:
Shops and supermarkets use IT on their checkout
counters to scan the bar code on the item purchased. This
type of system is used to calculate bills by automatically
recording the items as they are scanned. This information
is shared with the central warehouse magnetic readers if
payment is done with a credit card.

Libraries:

be scann put bar cog

ed w €S on bog

returned, Th; hen a book is borroweﬁs o
gl o




Computers in Education

It is very important to have some computer skills
in today's working world. As well as storing
student details, names, addresses, and so on.
Most schools now have some forms of computer
education. Pupils can learn about the computer
world and also make use of the ability to connect
to other learning institutions. Pupils can also
write reports using the computers and also use
CBT (Computer Based Training) materials to
study science, math, languages etc. Pupils often
make use of encyclopedias to search and find
useful information,

Real world example .
Distance learning systems: E-learning is a term
used to describe studying via the Internet.



Chapter (2)
Computer System

Objectives:
y the end of this chapter, you will be able to:

List four parts of a computer system.
@ Define the hardware components.

® Define the software components.

@ Define the data & information and list
their types.

Define the humanware.

Name and describe three types of

computers.




Computer System

In specific terms, a computer is an electronic device
that processes data converting it into information that is
useful to decision makers.

Computers are controlled by programming
instructions, which give the machine a purpose and tell
it what, when and how to do it.

Computers have many varieties ranging from the
small computer built into household appliances to the
super computer that helps scientists in researches, or runs
large scale applications.

consists of four

pHardware.
»Software.

» Humanware.
sData & Information. B




Hardware:

The word hardware refers to

any part of the computer you can
touch. S

Software:

Software is a set of instructions that order

the computer to perform tasks.
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Humanware:

Humanware refers to the staff who:

1 Maintain hardware.

2 Develop software.

4 S Design.

4 Operate and use.

Zamzam Presses



Data consists of individual facts or bits of
information.

The computer stores data of all kinds (words, numbers,
images, sounds, or videos).

Within the computer, data is stored in files. A file is
simply a set of data that has been given a name.

Data types:

Wor0s Number
WELCOME 3 :

2
Tmages

Sounos

The Computer



Compufer Types

A PC isacomputer, designed by IBM in 1981. Many
different companies make PCs, but all of them are
IBM-compatible. What this means, according to Bill
Gates, is that they will all run Microsoft Windows.
Capacity: Average hard disk size is from 40 GB to
512GB.

Speed: Average speed is from 1 GHz to 3 Ghz.

Cost: Fairly inexpensive.

A Mainframe is a big powerful, expensive computer
that can support many users at the same time. Large
businesses and organizations use mainframes.
Capacity:capacity of several hundred or even
thousands of PCs.

Speed: much faster than PCs.

Cost : highly expensive.

Macs have a different operating system and use their
own software and hardware.

Capacity: Average hard disk size is from 40 GB to
512GB.

Speed: ranges from 500 MHz to 3Ghz

Cost : fairly inexpensive, but usually costs more
than anequivalent PC.




A Laptop, or notebook, is a lighter and more
portable version of a PC or Mac that can run
on batteries.

Capacity: Average hard disk size is from 80
GBtoover than 512 GB

Speed: Fast, but slightly slower than a PC.
It’s average speed is from 700 MHz to 3 Ghz
Cost: Fairly inexpensive, but costs more
than an equivalent PC.

A Server computer is a central computer
attached to a network where users on the
network can save their files and information.
Capacity: Greater than a PC, often more than
512GB.

Speed: Generally faster than a PC, may use
multiple CPUs.

Cost: More expensive than a PC but not as
expensive asamainframe.

Personal Data Assistant (PDA):is a handheld

computer that is generally used to keep track of
appointments and addresses, and stores small files.
Capacity: Much smaller than a PC - 64 MB to 8 GB
of storage space.

Speed: Much slower than a PC - 8 Mhz to 266 MHz.
Cost: Expensive when compared to the capacity of a
PC.




Worksheet
Tell Me
How to get an appropriate compute£

Which Type of Computer do you need?

Type: Type:

Size : Size :
‘Speed : Speed : Speed :
Cost: Cost: Cost:

Can | Just Buy the Most Expensive
Computer | Can Afford?




S

Worksheet

Draw a line to match the five.
Steps for buying a computer:

‘Stepm Buy that computer!

Find hardware to make

Step 2> / the software go.

Shop for service and
Sfep é support.

Decide what you want

..... the computer to do.
Step
| “ Find software to get
ST 65\3 that job done.

-~

The Computer






Chapter (3)

Hardware

Objectives:
By the end of this chapter, you will be able to:

® Define Computer processor.
® Define Computer memory.
@® Define Input & Output Devices.

® Define Storage devices.



I«;m\puter' processor:

It i1s hidden inside the system unit [t is a
particularly important part of the computer,known
as the central processing unit (or CPU, for short).

It is responsible for data processing in computer.

| '
i = = e @ = =)

Computer Memory:

A RAM is a computer's temporary storage place, where it
gets its work done. For example, when you use a word
processor to type a letter, the letter is stored in the
computer's memory. The amount of RAM, or memory, is a
very important factor in a computer's performance.
Generally, the more RAM a computer has the better its
performance.




Input :
You communicate
with the computer
via an input device
such as:
A mouse
A keyboard
A joystick.

Mouse: The mouse is used :

* Pointing
* Selecting

* Drag and drop

* Open drop down menu

Process/Storage Output :

The computer The computer
processes data, communicates its
makes calculations,  results to you via an
directs the work to  output device such as:

the hardware, and A Monitor
stores your files. A Printer
Speakers.

Keyboard: This is used to input
data into a computer. With a
keyboard, you can enter
commands, select menu options
and enter data into applications.




Ices.

Light pen: A special pen that lets you
draw directly onto the screen,

doing mouse functions

Touch screen: Similar to an ordinary
computer monitor It has a thin, transparent
laycr of plastic covering it, that’s touch-
sensitive. When you touch a part of the
screen, it has the same effect as if you
clicked on that area with a mouse.

Joystick: A hand-held stick that can
be moved around in any direction.
Used mainly for playing games.

i

Touchpad :Often used on laptops. With a
touchpad, you can move the mouse cursor
on the screen by touching the pad and
moving your finger around. The two
buttons, on the touch pad, simulate the use
of the left and right buttons of a mouse.




Trackball: Instead of using a
mouse, you can also use a
trackball. You can use your
thumb on the roller-ball to move
the cursor on the screen.

Graphics Pad: This is a square
piece of material that you can use to
draw pictures (for a mouse is not
always practical for drawing
complicated lines and shapes).

]

Scanner: Used to scan
images/documents into a computer.
It can be flatbed or hand-held, it is
also used for Optical Character
Recognition (OCR) and to scan
microfilm/transparencies and
negatives.




N

Out

|

t devices:

Monitor:

monitors.

The screen/monitor/visual
display unit is the part of a
computer that displays the
current process or application.
- There are several types of

Laser Printer: These are large,
expensive printers that work
like a photocopier. They usually
have very high quality printouts
and can print very fast.

Inkjet Printer: These are
smaller, cheaper printers that

use a little cartridge to spray a '
jetof ink onto the paper. l h/
= T

- Plotter: This is a special type of

printer that draws pictures based
on commands from a computer.
They are used by engineers,
advertizement personnel and
designers who need to draw
complicated diagrams.



Storage:
A PC processes data in streams of

bits (the smallest component of
computer data). Each bit can be in

[ 00 0 0 ®e K
one of two states: 1 or 0 (on anq off). e TR —
These states are known as binary i, T —
digits. Bits are combined in sets of i, 158 Yok, RIBIG.
eight to form a byte. Bytes are used = iy VG Nowhiuse. BB
to represent data such as characters el O W NEUERS
this table bellow represent the = sk e WA Gk RS
example of (bit - byte - kilobyte - = LEE1H) il it (36 Mrekotly. DEIBHY
megabyte -gigabyte)

— Size
Unit Abbreviation  Sijze Symbol  Equivalent
A single Letter,
Byte B 8bits @ Number or
Symbol
; A one-page,
Kilobyte KB 1,024byte @ Ameren,
letter
. A best-selli
Meiibyte MB 1,024Kilobyte Q ol T
Gigab AR
e GB 1,024Megaby encyclopedia set
te
Tenbyte TB  |1,024Gigabyte A bookiore
1,024

The Computer
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= l,_E._!,, Storage devices

Zip disks can store 100 to 250
Megabytes (MB) on a removable disk-
about 70 to 170 times as much as an old
floppy disk.

Zip drives are available in both
100MB and 250MB .

-

Jazdisk canstore | to 2 Gigabytes (GB).
Jaz drives are also fast, though not as fast
as a hard disk, so they are great for backing
up information.

l :
A tape drive creates copies, or backups, of
the files on a computer’s hard drive onto a —
tape cartridge. The backed up files can be ’J
» -

restored in case the original files are lost

due to a disaster or lake of experience.
-

Flash cards are commonly used as the 'film'
for digital cameras as well as computer
portable storage. Flash cards can store
anywhere from a dozen to several hundred
pictures, depending on how much memory

I__’.thcy have. There are three different types of
:?’:;/ flash cards: Compact Flash cards, Smart

o Media cards, and Memory Sticks. Flash
cards can store anywhere from 4 MB all the
way upto2 GB.

USB flash drive is really another type of
Flash Card that plugs into a USB port. USB
flash drives range in sizes from 16 MB to 4
GB.

Sy me




A hard drive or hard disk is a computer's main
storage device. Most hard drives are tucked away
in the system unit of a computer hidden from view;
hard drives can usually be heared whirring inside
when you start the computer. An external hard
drive resides outside the computer's system unit.

can only read information. You can't save, or
record anything on them.

CD-ROM drive : used for read CD-ROM
disks.CDROM stands for:

Compact Disc-Read Only Memory

CD-ROM disks: CD-ROM can hold more than .
600 Megabytes (MB) of data, most CD-ROMs é
-
5! . . \"T" :

Floppy disk

/

Some desktop computers still have a floppy
drive, althoughsome laptops have dropped the
all-but-obsolete floppy drive. Floppy drives
read flat, 3%2-inch floppy disks. Floppy drives
are as slow as molasses when compared to
hard drives and CD-ROM drives. Floppy
disks can only store 1.44 Megabytes (MB)
just a little more than your typical novel.

DVD
Digital Versatile Disks used to storel ’\
data, can hold more than 4.7 GB I = n

The Computer



What a ccomputer; power'fuI’
Proc ssor Speed:

A computer can do bllllons of
actions per second.

Religbility

Failures are usually due to
~ human error, one way or
\. another.

Hard Disk:

A computer can Keep huge amounts
of data.
The more bytes your hard disk has,

the more data/software you can
store. J

Membory:

The more memory your computer has,

the more applications you can run at

the same time. Increasing memory also

improves system performance.

Like a ballet dancer; the wider the
“.space she has the better she can dance.




Worksheet

%

Arrange the following storage device
ascending drive to storage capacity :

The Computer




Choose the word that best describes the

picture and write the word in the blank space.
Scanner system unit monitor
Mouse digital camera printer
Keyboard trackball speakers




Worksheet

Qutput devices receive information from the CPU and translate it

into sound or images that we can understand.

Input devices allow us to send information to the CPU to tell the

computer what to do.

Write input or output in the blank next to the components

listed

Monitor

Keyboard

Scanner

Graphics

Trackball

Laser printer

Mouse

Speakers

Digital camera

Touchpan

The Computer






Chapter (4)
Software

Oijecfives:
By the end of this chapter, you will be able to:

@ Define Operating systems.

@® Define Applications.

@® Define Utility programs.




Information Technology

SOf?WOI“e :

Programs: is a program that tells
your computer what to do.

Programs translate between
users and computers.

Types, of programs: |
Operating systems-Applications-Utilities

- Manage files and disk drives
- Ali_ocatc and stor data in an argamiged way

B . ~
- Monitor and follow up work

Allocates
Resources

Manugzs
Disks & Files

Monitors
Activities

Zamzam Presses




Applications:

There are many different types of programs for the
computer. They are grouped according to the tasks they
perform. Here are some very common types of programs and
some examples of their uses:

'dord processing: Spreadsheets:

- Letter writing - Storing financial
- Essays information
- Writing stories - Using functions
Database: Entertainment |
-Ad(.h:ess t.)ooks - Music programs
~Mxiiing lists - Video programs
— - Games
Education
- Skill practice games - Macromedia programs |
- Tutorials - Movie programs
- How-to do programs - Browser programs

—

\




ay's computer viruses are more
sticated and aggressive than ever.

kfully, with anti-virus software,
can confidently keep your data safe




Software model:

The operating system receives messages from applications
and instructs the hardware system to process and/or calculate
data. The results are passed back up the chain of events to the
user.

1 Hardware .
2 Operating system .

3 Application .
4 Data .

The Computer




worksheet ﬁ

Choose words from the word list to fill in the blanks:

Word processing  Spreadsheets Database

Entertainment Education Operating system

| [y works with words to help you
write letters.

2) i, helps you use functions.

%, ) Programs translate between

users and computer.

4 ... helps you do Mailing lists.

) s helps you leam new skills.




& worksheet

Which one of these tasks considered as an
operating system function :

[ ] Acts as an intermediary between the user
and the physical components of the computer .
[] Convert data from one format to anoter .

[ ] help in writing text .

Which one of these functions that operating

system does :

[] Drawing a picture .
[] Determinig the working program .
[] Storing file on disk / CD.

[ ] Running a chess game .

The Computer

| ad






Chapter (5)

Data & Information

& Humanware
Objectives:
y the end of this chapter, you will be able to:
® Define Data.
® Define Information.

® Define Humanware.
® Define Programmers.

® Define Designers. ,




Sources of information:

Televisions, radios, newspapers,
books magazines, conversations,
etc... are all sources of information
At work people use information to
produce goods and services. Most
information at work is handled on
paper.

Information technology(IT):

Is a combination of computers , accessories
that handle processing and storing of
information that is contained in text, text,
picture, and voice.

I'T combines technologies :
Computing.

Communicating.

Of information as well this is
called telecommunication.

Tele communication :

Telecommunication is concerned with carrying
or moving information around over distances in
the form of a coded electrical, light or radio signals.

Carrying, processing and storing information

Like the human brain, computers handle
information as electrical signals. All the
information [voice, text, pictures, etc.] carried,
processed, and stored, as a series of electrical
signals by both the computer and the brain.



Data:

Data is the new material for information.
Data is organized into files, and consist of
raw facts, it does not have any meaning
until it is processed and turned into
something useful.

Data comes in many forms, the main forms
are letters, numbers and symbols.

Information:

Information. For example the three
data items above could represent

tasks in formation help for taking
desisons .

It is sent
Sent to
somebody
CARRIED
It is
Received gccepted
or
rejected.
It is stored - ‘
[for the Itis
long or _changed
short term] (classify -arrange I
Stored

The Computer



How dose computer process data?

There are two components that handle processing
in a computer.

The central processing unit
(or CPU)

The place where data is processed .

Memory
The space where the
computer can quickly
read or write programs
and data while they are
used.
Main memory

This is where the computer stores the
data and commands that are currently
being used. When the computer is
turned off, all data in the Main Memory

vanishes. A data storage method of this
type is called volatile since the data

| "evaporates”.




CPU

Stands for Central Processing Unit

This is the part of the computer that does
the "processing”

Input
Device

A

Input/Output Storage monitor

Output

Device
Input/Output Devices
When you enter new data, the
keystrokes must be stored until the
computer can do something with it.
When you want data printed out or
displayed, it must be stored
somewhere handy first.

-~

The Computer




Every CPU has at least two basic parts

ﬂ The control unit

All the computer's resources are
managed from the control unit. Think of
the control unit as a traffic cop directing

the flow of data through the CPU, as
well as to and from other devices.

TN E

alectrical slgnal

2 The arithmetic & logic unit

All computer data is stored as numbers, much of
the processing that takes place involves
comparing numbers.




Humanware:
Designers .

Graphic designers develop the overall
layout and production design of magazines,
newspapers, and advertisements. They
decide on the most effective way of getting a
message through a printed, electronic, or a
film media using a variety of methods such
as i1dea, color, type, illustration,
photography, animation, and various print
and layout techniques.

Builders.

Those who participate in
computer manufacturing.

Programmers.

Computer programs are instructions
that tell the computer what to do, which
information to identify and access, how
to process it, and what equipment to use.
Programmers write programs according
to the specifications determined
primarily by computer software
engineers and systems analysts. The
programmer codes those instructions in
different programming languages - as
Prolog, Java, and C++ - depending on
the purpose of the program.




Data Processing activities

ata processing consists of three basic
tivities :
& Capturing the input data.
#Processing the data.
&Managing the output results.

Capturing the input data:

Data must be recorded
.~ orcaptured in some form

,/'&‘@ before they can be
\W processed .

One or more of the following
operations have to be performed
on the gathered data:
. Classification,
. Calculation,
S LN Sorting,
Comparison,
Summarizing.

Once data has been
captured and Processed,
'ﬂ one or more of the
MU~ ) fallowing operations may
5" beneeded:
Storing and retrieving,
communicating and
reproducing.




Chapter (6)
Infernet concepts

Objectives:

By the end of this chapter, you will be able to:

@ Define the network and innumerate
benefits of using a network.

@ Define the internet.

@® Define a web site and a web page.

® Define navigating.

@ Define a hyperlink.



Networks

A computer network consists of two or more computers that are
connected together. They could be in the same room, in the same
building or on opposite sides of the world.

There are several benefits of using a network:

[-Sharing resources such as printers:

If you have two PCs but only one printer, the PCs can be
connected to the printer and share its resources.
[I- Sharing files and data:

Instead of making lots of copies of a file, like company letters,
one copy could be stored on a particular PC and everyone could read
1.

[11- Fast diverging and effective communication:

To help people work together better, users can send messages to
each other through their connected computers.
IV-Reducing costs as devices can be shared:

Saves time as communication is as fast as it could be, keeps
confi dentiality as data and information pass through safe pathways.

T
. E! % ‘1/
‘ e : ?./

Shared laser prinres.

Server Nenvark laser printor.
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Unless you've been living on an isolated island,
you already know that the Internet is the biggest
revolution in computer technology. You can't
ignore that the Internet has changed the world.
Fortunately, for the most part, the Internet is
incredibly easy to use. Even the most computer-
phobic users seem to feel right at home on the
Internet.

The Internet is the largest computer
network in the world. It consists of
millions of computers all over the
planet, all connected to each other.

The World Wide Web is what you
probably think of when you think of the
Internet, although it's really just a part
ofthe Internet.




s the web?

The World Wide Web is a collection of electronic
documents that are linked together like a spider
web.These documents are

stored on computers called ;o”%sfgf

servers located around the ==

world.

The Web has evolved into a
global electronic publishing
medium and increasingly, a ==
medium for conducting h-...
clectronic commerce. coMPTER

What cke the requirements to connect
to the internet ?

The Web consists of’

Your personal computer Web
browser software to access
the Web, a connection to an
Internet service provider
(ISP), and servers to host the
data.




Web pages are stored on web
servers located around the globe
Entering the (Uniform Resource
Locator) URL of a web page in
your web browser or clicking a link
sends a request to the server which
hosts the page. The server sends the
webpage to your computer and
your web browser displays it on
your screen

What is the Web page?

A web page (such as the one you are looking at
now) is an electronic document written in
a computer language called HTML
(Hypertext Markup Language).
Web pages can contain text,
graphics, video, animation,
and sound, as well as
interactive features, such as
data entry forms.Each page has
a unique address known as a
URL (Uniform Resource Locator),
which identifies its location on the
server.Web pages usually contain
hyperlinks to other web pages.

The Computer



A website is one or more web page that
relate to a common theme, such as a
person, business, organization, or a
subject, such as sports.The first page is
called the home page, which acts like an
index, indicating the content on the
site.From the home page, you can click
hyperlinks to access other web pages.

the Web:
There are many ways to move between
web pages or websites: Clicking a text
Hyperlink, Clicking a hyperlinked graphic
image, such as a button, photograph, or
drawing, Typing the URL of a web page in the
location box (also known as the address field)

of your web browser and pressing the Enter or.
Return key.

L)

A web browser is a software program used . IiSrnet

to access the World Wide Web. A browser Explorer /
(also known as client software) retrieves
data from remote web servers and displays
a web page. The two most popular
browsers are Microsoft Internet Explorer
and Mozilla Firefox. Browsers basically
work the same way. Once you know one,

you can easily learn the others.
/




Using Web URLs:

A URL indicates where the web page is stored on
the Internet. Some large web sites
have multiple URLSs that access the
same site. The location box or
address field on your browser

indicates the URL of the page you
arrived at after clicking on a link. {1

How Hyperlinks Work :

A text or graphic hyperlink hides a
URL. Clicking a hyperlink passes
the URL to your browser.Clicking
different parts of a linked graphic,
called an image map, takes you to
different web pages or different
places on the same page. In
addition to pointing to web pages,
hyperlinks can access media files,
such as sound or video clips.

The Computer
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Information Technology

Internet services :
Send and Receive E-mails:

The

Zamzam Presses

Exchanging electronic mail (or e-
mail) is the most used and most
popular feature on the Internet.
Just like regular paper mail, you
can send and receive e-mail with
people around the world, as long as
they have access to a computer and
the Internet. Unlike regular paper
mail, e-mail is usually delivered to
its destination almost instantly.

World Wide Web

The World Wide Web is what
comes to people’s minds when
they think of the Internet although
it's really only a part of the
Internet. The World Wide Web 1s
an e¢normous collection of
interconnected documents stored
on Web servers all over the world.
The World Wide Web has
information on every subject
imaginable.



Search:

You can use a search engine to find just about
anything on the World Wide Web. A search engine
catalogs the billions of Web pages on the Internet so
that you can find
information on the topics
that interest you. Google
and Yahoo are two of the
most popular search
engines out there.

Multimedia on the Web:

Sound, video, animation, and 3D
interactive video are referred to as
multimedia. Some multimedia is
called streaming media, plays as
soon as you access a web page.
Others require that you download
the multimedia file to your
computer first. Multimedia files
often require that your browser use
aplug-in program.

The Computer
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WANAOWS
o Revision
Objectives:

By the end of this chapter, you will be able to :

@ Dcfine Windows desktop.
‘ Move a Window.
‘ Size a Window.

‘ Open windows .

@ Use the Taskbar to Manipulate Windows.

‘ Move Between Foreground and Background Windows.




~—

Windows deskiop

Windows | |
—_ ~ Label the diagram below by editing the name of the
desktop feature in the blank next to the corresponding
number.
»
}
Start menu | 1
.‘ Clock B
| 3
My computer ic0n
.’ My 4
M v doc“ment icon 5
Minimized windows 6
| 7
- Taskbar 8
Recycle bin icon

LA
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:
How to prepare a screen saver Arrange the following Ji l
steps to a screen saver : Windows

Right click on free " |
NVIDU Displa ’ space on desktop .
New ’
QChoosc the proper.

screen .

wadane  Click on the black arrow, the
. next menu appears .

Choose properties and

activate the screen saver
tab .

Click on Apply



o

Wind

Sizing a Windows

Re-arrange the following procedures to size
“My Computer” Window.

When you see a scroll bar in a
window, it indicates that part of
the window is hidden and you
must scroll through the window
to see the remaining items.

* You may also size both the
vertical and horizontal borders at
one time. To do this, move the
mouse to any comer of the
window until the pointer
changes to a diagonal double-

headed arrow.
LY

* Click and hold the left mouse
down on the corner border and
move the pointer to the left, right
and up ordown.

& Al I

F ]

\.(Click and hold the left mouse
down on the border and move
the pointer to the left or right
(vertical borders), up or down
(horizontal borders).

: 3

\/ﬂxe window should expand
or collapse. When you have
the window the size you
want, release the left mouse
button.

b

\/Place the mouse on any
border of the window. The
pointer will change to a
double-headed arrow.

e




Open Windows

Re-arrange the following procedures to open
a Window of each program below

prm—

Click Notepad. ( )
' Point at Accessories. (o
| ' Pointat All Programs. ( )
| Click Start. ()

;R.. ?

Click paint.

Point at Accessories.
Click Start.

Point at All Programs.

0
(]
]
-]
(]
l&]

- : (
I == L <]| FClick Calculator. (
(
(

cloooe o Point at Accessories.
/B EEa0E] Click Start.
Dloown]




[2

WordPad
i Cli
lick on Stary menuupo,‘:‘k on S;‘;’"menu,

PointatA : atA]
ointat A 1 Pr Ograms, Point 5¢ A ; TOgrams,
ickon Pajpy, onWordpay
* Right-click the taskbar '
in an empty spot.
e cVertically: | oo :
windows ertic
\ thetaskbar inan €mPtY | e Wk i
\ly :owhl‘n::: *
: Horizontd
lick Tile W“:)?:::l All Progfams Task Manager |
(? " es, Click Solitaire: “**"'?"‘;'\ |
Click Tile w‘ndov:‘fb*;f'{:\z::?mp ‘ "3
: 1a
Right-click ¢ \ This ope h
L . : s
de Windows Popy Ortey
Click Cascd the taskbar in an empty open P meny, for >
Right-chi¢ ‘ Objects the
\ SCry ecn. on th e

“ .
S’cp\‘i)ck Show “.“’.D‘?‘Sﬁ\ the open \
This will ™ {o buttons ©on




Moving Between Foreground and Background
Windows

You have opened three
programs. The last program
you opened is on top. It is
the active and foreground
window. Notice also that
the title bar is highlighted.
The other two programs
are inactive and in the
background. Their title bars
are gray or inactive.

To move between foreground and

background windows
0
. 60
L s \as\‘w
ver® T o™ ot
X a“‘iw. ot e Q(Og‘a‘“
C\\c W ac\,\qe ‘ng e
ke’ e
UOP T aetiNe Click on Ny ;
ant C Cpad w
K c:l:cc:f O Paint g,
on C, Iculatorw d
C"Ck on
g’.ick on Py ::P utt,
i n
¢k on ¢ Culat, r bug
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Searching For Files and Folders

Objectives:

By the end of this chapter, you will be able to:

‘ Practice finding information that is stored
in the computer.




| —

Today's computers allow us to store a great deal
of information. Because of this, we suggest that you
should keep your information well-classified and
organized so that finding it is an easy process. Despite

having the information well-classified, it can happen
L that sometimes we cannot find a file or folder. When
this occurs, we can resort to the Search function

} provided by Windows to locate the file or folder
quickly. The search provided by Windows XP also
} allows us to search for hardware, a network, people in

the directory, Internet pages, etc. We will further
discuss this later.

Searching for Files and Folders;
Bringing Up the Search Window:

L Click on the Starticon Wt darsnients’ &

2 (Click on the Search option

3Click on
All Files and Folders. 4,-;5:‘.",‘_'?,;"?;»,3




A search window similar to the one shown below
will appear, asking you what kind of search you
wish toperform.

Fle Edt Vew Forcrkes b Help 5

O Q| P | rin [ S
nddess| ) seachResks ' 1>
Search Companicn X Tostart your coach, Folow the Instructions 1 the left pane.

| Windows

What do you want to search
for?

m.mdt.am_’ 1
n@m‘:"w—) 2
&) Computers or pecole — 4 ¥,
W) Infomaton 1 Heb and ]

Support Cerner

You mary also wank to...
4 Search the Internet
Bmm“
S Turr off anmated character

First, we need to choose one of the options
presented, depending on what we are looking for.

1 Pictures, music, or video.

2 Documents
(Word processing, Spreadsheet, etc.).

3 All files and folders.
4 Computers or people.

5 Search the internet.



Windows '\ Searching for Files and Folders :

e

Specifying the Search Parameters :

In the first field shown on the left side of the search
window, enter the name of the file or folder you are
searching for.

Choosing “All files and folders™ a screen will appear
so that we can give more information on what we are
looking for.

Search Companion

Il or part of the file name :

‘Search by any or all of the
criteria below.

All or part of the file name:

upatms 1
A woed or phrase in the file: ;
| 2

' l we will put All or part of the file name that
we are looking for, and then windows will
show us files or folders that contain the
characters that we have typed.

Look In: o ;
| Local Hard Drwves (C:;O:;E:;Fs;
When was it modified? ¥

what size is it? ¥
More advanced options ¥

A word or phrase in the file :
Ve can type the text that the file we are
looking for should contain is not always
convenient to use this box because this

significantly slows down the process as it
looks for that word or phrase in each file. T m%
Look in : 4
FWe can indicate in which unit we wish to JElick Search
look for the file or folder. Click Search to start

the search.




0

A search window similar to the one shown below "‘ I

will appear.  Co———rY |
NS ..

ﬁn case that
Windows finds

anything,

Itwill notify you in | | SSSSats =

the window to the T Set ¢ gt Thr v ¢ s s d
e

(Stop
While it is carrying
out the search, we
can stop the search by
clicking Stop.

m case that Windows does not find
anything, it will notify you in the
window to the right with a message
saying that

the search has ended and that there
are no results toshow.

Sorting Through the Search Results

The search results will appear on the right side of the
window.

The operations we
carry out on the files
or folders found by the
search are the same
ones thatwe can do on
any other file or
Sfolder. We can copy,
delete, change name,
elc....




WInaows Searching for Files or Folders:

Searching for a file or folder in the hard Disk.
| Finding information that you do not know where it
is stored.

1 Display the Search menu and select the

option All files and folde.

2 Write the name cale in All or part of the
file name: box.
3 On Look in select the C drive.
~ 4 Click on Search to start the search. =
5 On the window to the right, the calculator
will appear, as well as other files and folders.

Start a new search:

If the calculator

: 2 does not appear, do not
We will use variables.

 worry because itis
Click Start a new search. ~ possible that you do
~_not have it installe

1 On the “All or part of the file name:™ box write calc*®
this way only the files that start with calc will appear.




| Windows

.- | | N

worksheet {. //
Do a search personalizing it by indicating
dates and types of files. Click Start a new
search.

1 Open the option “When was it modified?”.

2 Select the box “Within the last week”.

3 Open the open “More advanced options™.

4 Click on “Type of file™.

5 Search for and select the row Microsoft Word document.
6 Click on Search to begin.

If there is a file that meets|
these criteria it will appear
in the window to the right.

Exercise :

1 Search for the file calc in the drive C.

2 Search the files modified between |1 5/02/2001 and the
7/02/2001.

3 Search files or folders that start with Ex, but only in the
folder My documents, not in subfolders.



LN

Wy
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WANAOWS
Searching For hardware

1 Objectives:

y the end of this chapter, you will be able to:

Practice searching for hardware in your network.




.v~’

| —

If your computer is connected to a network, this
option will be useful since it will allow you to access the
resources that are shared by other computers within the
network. Your computer, for example, can use a printer
that is connected to another computer, as long as you
have the required permission.

To use this option you need to do the following:

. 1 Click on Start menu.

i 2 Select the option Search.

3 Once the window has
opened.

4 Choose Computers or
people.

You may also want to...
) Smarch the Tnbamat




Then A computer on the network, and the next
window will open up.

Windows
Which computer are you looking for?

1
Computer name: 1 ( ‘-/ -

| Computer name:

— you need to properly

You may also want to, .. type the name of the
&) Search this computer for files ::ot-pu;er t)l"ou .ar.et
ooking for, otherwise i

4 Search the Intermet D is probable that it will
not find it. _

Search I

The way this window works is similar to the way we search
for files, the only important difference is that the box looks
for a Computer name:

e

—

—

P—




Witdows || Searching for Hardware

Searching for hardware in our network. If your
computer is not in a network, this exercise will
not be very useful.

1 Display the Search menu and select the option

Computers or people. G
2 Write in the name of the computer that exists ned

onthe network.
3 On Lookinselect the Cdrive.
- 4 ClickonSearch to start the search.
5 On the window to the right of the hardware that

you are looking for will appear, as longasit m—
exists within the network. ST

‘Whach computer are you looking for ¢
ﬁwmn-

‘)cumdnmn...

&> Smarch this computer for files .

.4 Search the [nternet

If the hardware you are
searching for does not
appear on the search but
you are sure it is in the
network it could be that
you wrote the name wrong

or that your network is
wrong.

)




worksheet

Exercise :Choose the correct option:

Windows

To search for hardware on the network
you need to: {

A From the Start menu choose hardware
from the Search menu.

B From the Search menu select the option
Computers or people and then choose A
computer on the network.

2 If you are looking for a file named

A We only get files named John.

B We get files that contain the name John,
like Johnny for example.

C Option B, but we also get folders.
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Searching For pepole in address book

Objectives:
By the end of this chapter, you will be able to:

‘ Search for a person in the address book.




Searching for People:

If you have Outlook or another similar program, it is
probable that you have an address book, which is like
an agenda. This option allows you to search for the
name of a person in the address book.

To use this option you need to do the following:

} ' 1 Click on Start menu. Ooun |

2 Select the option Search. | mpogus P Drn.

3 Once the window has
opened.

4 Select Computers or
people.

5 People in your address
book.

You may also want to...
mmm




The following window will open.

Next we need to indicate some
search criteria, such as:
Name, the email address,
the phone number, etc...

If we enter various criteria, it is
necessary for them to coincide in
order to show the result.

In the box Look in: we need to
- indicate if we want to search in
the address book of our
computer or in the address
book of other people through
Internet, which will appear by
clicking on the arrow to the
right.

Once entered, we
can click Find now
to begin the search.

]

If you wish to delete the
search information that you
entered to do another
search, click on Clear All.




Rl Searching for People:

B ] Searching for a person in the address

1 Click on Start menu.
2 Open the All programs menu and click on Accessories.
3 Select the option Address book.
’ 4 Click on File and select New Contact.

5 Fill in the boxes with one friend's information.

6 Once these boxes have been filled in, Click on OK.

To search for the name in the address book:

1 Click on Start menu.

2 Display the Search menu and select
the option Computers or People.

3 Select People in the address book.

4 In the name box put your
friend's name.
5 In the e-mail box his email
address.

6 Click on Search now to
begin the search.




Exercise Searching in the address book

1 Search in your address book a person named Hussien.
(Write the steps)

21f you find him change his phone number, try with |
another name. (Write the steps)

3 Choose True or False for each statement.

you
name of a new person and the email address, you will get as
result the people with the same name or with the same email
address regardless if they have the same name.

B When I look for a file or folder I can only see it, I cannot
change or delete1t.

(C To look for computers in the web I need to have the name
written properly and completely.
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Printer

Objectives:
By the end of this chapter, you will a able to:

® Install a printer.

® Configure a printer.




Installing a Printer:

As we have already seen in the units before, it is very
easy to install new hardware, such as printers, since the
majority use Plug&Play technology. This allows the
operating system to recognize the new printer by
simply plugging it in. Nevertheless, in some cases, we
may need to do the process manually. When we plug a
} printer into our computer it is necessary to install the
l appropriate drivers so that our computer will recognize
, it. Next, we will learn to install a printer manually and
to customize it to our needs.

Windows

Qmmrm
1 Open the Start menu. P —
2 Select the option oy seuch

Printers and Faxes. | Al programs [ b LT

If you do not have the option Printers and faxes
on your Start menu

Faxes

1 Open the Start menu.

2 Select the option
control Panel.

3 Double click on “Printers
and Faxes”.



A screen like this one will appear.

S Printers and Faxns !
Fle Edt Vew Favorkes I ™ ¥
“ These tasks are :
On-O 3 the ones that are Windows
Arn S Rirters and Faxes v (£ Go usually needed to '
v‘."'.. handle a pr_inter .

if your printer is connected
directly to your computer or if it is
on the web. s

[ sl

W which port it is connected.

astereecs LTS smma—m
o Wt et B0 PT I e — - A p—

S Yo And then a screen like the one
i shown below will be displayed so
that you can choose the
manufacturer and the type o
printer. Then Windows can install

¢ appropriate software.

Lot L | few |

You can also use the disks provided by the
manufacturer, if you have them, or search




Print Manager:

The print manager shows the documents that have

Windows

I been sent to the printer. Through the print manager, we
can cancel or pause a document.

To manage the print manager you need to open the
appropriate window in the following manner:

Click on the Start menu. gy Prnters and Faves
: Click on the Printers and faxes. /™5
| o mch

Printing Freferences, ..

Pausa Printing
Cancel All Documents

On the left hand panel,
select See what is printing.
This will open a window
where a list of the
documents being printed or
waiting to be printed will
appear.




The print manager is very useful because we can
cancela documentifwe do not want it to be printed.

Windows

L ———

It is possible to restart a print job that has been stopped by
turning the computer off or by pausing the documents to give
way to more important ones.

When we send a document to be printed, the printer icon will
appear in the notification area on the bottom right of the screen.
Usually an icon will also appear, depending on the program we
are printing from, such as Word, Excel, Paintetc...

1 3 4 5
&'Auplr aserWriter 12/640 PS - ‘t >
Erinter g Yieve Help
Document Name Status Owner Pages Sce
8] Test Page Ervor-Print...  abeer 1 88,9 KB/88.9 KB
[#) picture OftLine - Fri.  sheer 1 20.9 KB/ 20.9kB
< >
1 document(s) In queue

You can see that the name of the document we have sent to

print appears

|- In this example:
(text page / picture).

2- Next is the status of the document
(Error-Printing/Offline -printer). .

3- The name of the person (owner) who sent the documen

4- Number of Pages.

5- The size of file

when it was sent to the printer also appears.



Windows

—

b Apple

eserli riter 12/640 PS

To delete a document:

from the print manager you need to select it and

click on Delete.
To pause a documents:

open the menu Document and click on Pause.

To delete all documents:

from the print manager open the
menu Printer and select Cancel All
Documents.

To temporarily stop the printing of

all the documents:
open the menu Printer and select
Pause Printing.

% Printers and Faxes =115
Floe Edt View Favorkes > .

B S
em M c.’

Addeess | Sy Printers and Fave ¥ Go

mm-
‘ M

Set as Defak Printer
Priting Preferences...

Pause Printryg
Cancel Al Documecits

Shar ). ..
Use Printer Offine

To set the printer as the main printer :

open the menu Printer and select Set as Default Printer.
Setting a printer as the default printer means that by
default all the documents will go to that printer unless

otherwise indicated.



Draw a line to match between two columns
What the steps must do for:

Set the printer -Select document
Temporarily stop @ - Open the menn Document
the printing of all - Chick on Pause.
the docmmenta
Pause a dscument @ -Open the memm Printer

- Select Cancel All Documents.
Delste s doeamment .—Opmﬂrmnl’ﬂnh

Delete all documents @ @@ -Open the memm Printex
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Objectives:

By the end of this chapter, you will be able to:
Add New Programs.

Modify or remove programs.

Add Windows XP components.

Add or delete programs for w‘




WL Adding or removing programs:

—

In addition to the operating system, computers have other
programs installed. If one of them is not useful anymore
and we want to delete it, Windows has the Adding or
removing programs tool, because a program cannot be
uninstalled by simply deleting the files manually, due to
that when a program is installed Windows creates notes
on the Windows Register.

|
1 Open the Start menu. © vromreseron Q) coma
. : () Prrtes and Paves
2 Seclect the option ‘m
Control panel. by T § st tnemt
- search
3 Click on Al programs [ o L
Add or Remove programes. %) o

a window will display with the three basic options shown
on the left side of the picture as it appears below

e oy I CD0OM o Rospy i I
% r&mb.om-l-uaa C@
B procy s from Mo

Vo 2 fwe Wirndimes iy o4, douas Suern and
Wt upintes over e Tnborned, dhek Windoses

e o f= llfe




A screen like this one will appear.

[ Ty TP
E‘a Add aprogean frem COECM o Rosgy dek

QNN' % To add & srogram from & CD-ROM or fogoy dex, chck CD EHIP
..i. . Add programs fram Moroso’t

To add new Wirdows Feanres, device drvars, and

hwm
-

| Windows

Ad3Renare
Windows
Compormrts
>
ard
Defakts
In thls optlon we have two
basic possibilities:
Add a program from CD-ROM or floppy disk 1
L. Toadd a program from a CO-ROM or floppy disk, chck CD
B e
Add programs from Microsoft 2

To add new Windows faaturas, devica drivers, and
‘ system updates over the lrter:\ct, chck Wmdo‘ws [ Windows Uipdate ]

Update

Adding programs from a CD-ROM or
floppy. If the program we want to install ison a a— peolode i
CD-ROM or on a floppy, we will click on the
CD or Floppy button and a screen will appear
prompting us to introduce the CD or floppy in
the corresponding drive.

Adding programs from Microsoft. If what
we want is to add or update a new Microsoft

component we need to click on Add programs
from Microsoft, this will cause the system to
connect us to the appropriate web page through
the Internet.




~—

Windows Modifying or removing programs :

i

= Click on the Start menu. o
@) Hob and Sugport
Click on the Control panel /) sewch

I All Programs D 7 Rune

Click on Add or Remove programs.

|

[orr. LT

Iragams
M A Pree Gt we  (Towe . “

S —— = ] Click on “Add or
bt N Coruapihenk St Wrelees L08Ry <ol Remove Programs
P T TP = 1oee option, a window

3 Goosde Gmal Mt - ouDe . . G

& o o el will display W'lth

T acad Y Pttt 1.1 Ser 2190 the three basic
@ quanee il options.

The modify or delete programs option is shown on the upper
left corner because it is the option that is most often used. On
this screen the installed programs in our computer are
displayed.

To select the program we want to change or remove we have to
click on it. On the image above ANIO Service appears
highlighted. Now we can do two things with this program:

Modify its instillation or delete it.

To do this, we have two buttons, Change and Remove.
Although normally only one button will appear,
Change/Remove.




Adding Windows XP components :

We can modify the components installed in Windows XP Windows

either because we do not need them and we want to delete
them to free up space on the hard disk or because we want to
install acomponent that was not installed before.

1 Click on the Start menu. (- ) Prikers and Faxes
2 Click on the Control panel. Q)"*”*‘w
3 Click on Add or f)s"’"

Remove programs.

A window will display with the three basic options shownon
the left side of the picture, then click on Add/Remove
Windows Components.

You can see a list of the
components available.
From this list check the
component you want to 10 a8t 3 e 4 ot A e owcibon A i bon s
install or maintain.

1
2.

—

10 add on semscvn & : uhuhnmmuw Serrer W5 N ¥
o e conpoment sl by To s0e whar's included n 5 conponent. clek TR
Ned) || Cwcel

If you do not want to
install all the options of a
Totw Sk eaaed Lt . oty - S
M on i A . co:inplc]ment. ;:llnck Details
Co) Comn ) and choose the ones you
want.

Owserption  Inchadng \windoun aecessones and erburcemesd s I povs computen




If any of the components appears with a shaded slot,
this means that not all of the options of this component
are selected, and consequently the complete
component will not be installed.

P Indasing Satvice 0.0M8
v @ Intemet Explover 00ME v

2 SPalnkemal infmation Sarvicas 851 135m ¥

If you want to remove a component that
is installed simply uncheck the box.

Once the components that you want to install are selected :

- Click Next -

- Click Finish.
Beneath the list of components we have the total hard disk
- space needed to install the new components that we select, and
last of all, the total hard disk space available.
This information can be very usefull, especially if we are tight
on disk space, because this will keep us from trying to install
components that will not fit.

This is an example of the
window that will appear if
you select the component
Accessories and utilities and
you click on Details..., and
then you can select one
Descriphon:  Inckues Wi e vt o Ko accessory and see its details.
Tctal dek space requres S67MNB

Space avalatie o dak, 125745 HB

Towamom the check box A shaded box reeans that orly pat
the component vl be nstalied To see what's inclded n 3 componen, chok Detad

L || cews |




Exercise : Adding or removing programs
Choose the correct option.

1 Why is it important to properly uninstall programs?

A) So that they will not appear later on the task bar

B ) To save space.
C)BothAand B.

2 How can you install a System component that is not
currently installed?

A ) Selecting from the control panel Add or remove
programs, and then choosing Add/Remove Windows
component.

B ) Only by reinstalling the system.
C)NeitherAnorB.
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Adding new Hardware

Objectives:

By the end of this chapter, you will be able
® Add hardware.

® Install a camera.

® Lcarn about the Hardware state.




' |
LUOEN Adding new Hardware :

o It is possible to add new physical components to our
computer like a modem or a new monitor, just to name
a few examples. For the new component to work, our
operating system needs to detect it. Usually, Windows
will detect the new hardware automatically, but in the
event that it does not.

Drivers.

When new hardware is installed, the computer needs
the files that describe the hardware and allows the
| computer to communicate with it. These files are
known as drivers.

When we buy a modem, for example, a CD is included that
contains the drivers for the modem. When installing the
modem, the operating system asks you to insert the disk in
order to copy the drivers.

1 Open the Start menu. e \
' e“""’"‘"‘*h :3:2"'%-; '

2 Select the option
Control panel.

3 Click on
*Add hardware”.




For many hardware elements, it is not necessary to
open up the computer. For example, in order to connect a
mouse, screen, printer, or scanner we simply need to plug
in the cables to the corresponding ports on the PC. In :
the majority of the cases there is no confusion because of Windows
the fact that a given cable will only fit into one designated
port, and they are also color coded.

In other cases, such as installing a sound card or a
hard drive, for example, it will be necessary to open the
computer and look for the corresponding slots. In these
cases refer to the instructions provided by the
manufacturer -

Once everything has been placed where it needs to
go, turn on the computer, keeping in mind that a few
different things can occur.

This will be obvious because nothing will cause this |
scenario, there are two possibilities:

.

il
A) The o i iEass i LB
Perating syst &
hardivhie elemengt. ystem recognizes the pew § l |
, =

Windows will begin to instal] the

we will not have to do anything molr]:elr Ui Add Hardware

s not
B) The operating system doe

lement.
3 w hardware¢ .
recognize the ntemay ask for the CD with the

In some cases 1
drivers.



new Hardware:

In order to detect the installed hardware, Windows uses an
assistant to facilitate the installation of any physical

components.On this first window the wizard will ask if we
have the CD with the appropriate drivers. If we do, it
recommends that we close the assistant.

1 Click on the Start menu.

2 Click on the Control panel.

e ——

' AR cmewma | oy roeare wt v asm
| — - P
, T [ Rl '_:::"

Jo Q& e e T P Nrei S

-."b

3 Click on
hardware

&

o ———

a)No,lfmandaddadhbaMyd
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Once the assistant has started, it will try to detect the hardware

automatically. If the hardware is not Plug&Play, it will not be ‘
able to find it and we will need to ask it to show a list to indicate
the type of hardware we are referring to. (mouse, modem,
graphic card, etc). Next a screen will appear like the one shown
here displaying the models of the selected hardware.

[V s Wit & |
wt te el "
St B e drves g et 16 el o box (s b S 1
T vk imeoton teim s ek B o 1
Once the model
: is selected and
et T T ﬂl ~ you have click,
[ Pivmrarmseembmig the driver will be
SRS Rauimgan g RS PP 26 vl installed,
o s e W (Rewom

s | Met) || Coms |

This process consists of several steps that we have
summarized.



Installing a camera:

Windows XP allows you to connect a
myriad of hardware easily. As an example

- we are going to see how to connect a digital
camera there are constant improvements on digital
cameras. Being able to directly connect the camera to the
computer is one of these improvements. To do this :

I
‘ |- From the Start menu. (I

2- Select Control Panel. Q@
3- Click on Scanners and cameras. i
”Qvﬂ.u

| | - pu T
Scarrers and Cameras
(you will find it on the left side of the screen).

The assistant will start, simply follow the steps
to complete the instillation.

3

Pl wplt wtde Bon gy Swvnm o cortmtect
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The state of the Hardware :

When a piece of hardware stops running correctly, we can
check its state through the information that Windows
provides us. Sometimes the piece of hardware can work
properly from a mechanical point of view but its driver is not
installed properly, not allowing the hardware to work
correctly.

To see the state of the hardware of our system:
1-Select the Start menu.

2-Click on Control Panel.

3-Click on Performance and maintenance.

Click on See basic information about
your computer.

Windows will appear with the
General tab selected. On this tab.
we can see generic information
about our system, such as what
processor is installed, etc.

Now click on De
manager, which will
us to the next screen.

Co]) ()

Click on Hardware to

view this screen. ‘
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e Worksheet ki/ S

J Draw a line to match between two columns
- How to get this icons:

2 @ _sclect start menu.
-Click on control panel.
-Click on “Mouse”.

-Select start menu.
o ® -Click on control panel.
-Click on *Add hardware™.

‘ . -Select start menu.
-Click on control panel.
-Click on *Add or remove

programs.

® @ -Select start menu.
-Click on control panel.
-Click on *Printers and
faxes.
D @ -Sclect start menu.
-Click on control panel.
-Click on *Date and time”.

& -Select start menu.
-Click on control panel.
-Click on *“*Scanner and
cameras’”.




To see the state of the Hardware: | Ay } .

1-Right click on
“My computer” icon From Desktop.

| Windows

Open
Explore
My Computet
2-Click on * Properties™. o
Map Network Drive, .,
Discornect Network Drive...
. . Shortout
3- You will see this screen. g'.;'f
[
T g, KN X
> =
- =

A |
\‘/Writc the generic information l'U

l

of system: —
- |
Write the generic information 8

of what processor is installed:

—_ -
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Help & support

Objectives:
By the end of this chapter, you will be able to:
® Use the help .

® Solve problems using the help.




Windows The new Help and Support window provides
' simplified, centralized access to all types of help and
support, including help files on the computer,
’ troubleshooters, updates, and online support from a
~variety of sources. If you're connected to the Internet, the
latest news displays automatically under

"Did you know?”

} To getto Help and Support:

L 1- Click the Start button. ) sewch
2- Choose Help and Support. e,




Help and support :

Buttons across the top of the Help and Support Center
window help you get around within Help, as follows:

1 Back: After you go to a new page, you can press the Back

button toreturn to the page you just left.

2 Forward (right-pointing arrow): The forward-pointing
arrow to the right of the Back button enables you to
return to the page that you have just backed out of (if
any ).

3 Home: Takes you back to the first page of Help and
Support Center.

A Index: Takes you to the Help system index, which is the
same as the index at the back of a book.

B History: Displays a list of Help pages you have already
visited.

§ Support: Provides an overview of Support options
available from Microsoft.

2 4

'3) Help and S spor! Center

Windows

~




.

Help index, which appears
when you click on the Index
button near the top of the
page, displays an index to
the Help system, similar to
the index at the back of a
book. You can scroll
through the index using the
scroll bar at its right edge.

L

o wyrww i

@ ey o - e -

O DL R

If you locate an index entry
that matches what you're
looking for, click it, Then
click the Display button
below the index. If several
topics are available, a Topics
Found dialog box displays.
Click which ever topic in
that dialog box best
describes what you're
looking for, and then click
the Display button,

@ Help and Support Center

}?Aﬁm[m a Oherge

Click
]

—

=

To add 3 TSI from a € or Hoppy disk &
1 gum copye P in Cortral

dd JI% Programs, anc Hen dice LD or

I, Follaw the instructions on vour sareere,
£ Notes
o To spen 444 or Remave Pragrams, dick Start, cick

Control Panel and then double-click Add or
Remove Programs,

o When usng Add or Rerove Programs, 1ou can only
instal pragram: that wera written For Wincows
opersting systams,

Ralatad Togice
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Windows

e ——

1 Display the help and support.

A
=1+ (Il 0w do you use help =Y
Set ssarch options
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Explore the program
bjectives
the end of this chapter, you will be able to:

® Get started with Word.
® Explore Word .
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RS Woril

Many people use word more frequently than other
program. Although word is designed to be intuitive, you
will be able to use it more confidently and efficiently if
you first take time to get to know the functions in the main
document window. This will provide you with a better
understanding of the many powerful features offered.
Word-processing programs help you create professional-
quality documents because you can type and format text,
correct errors, and preview your work before you print or
distribute a document.

Microsoft word xp one of t

— processing progran
omu”‘ available today. You can u
word to compose and upde
a wide range of business a:

personal documents.

!wmd most sophistication wor

JM*»‘ v
Al B T
s "e"'::?-;ﬁ“"“
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the memus, tools, and other feahures found in
every Microsoft Office System program
window.

BEFORE YOU START

—

To beg in, ope n Microsoft Word. Yowr
scree nwill look like the one shown here

1 Open “Start menu™.
2 Select “All programs™.
3 Select “Microsoft word™

P
M pozumamt  Avcioaott Word

l ozv W aa Lt wid o we dl mehr AR
DAL AR o e

N 19 &2 i3 gl < O
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Tt b BPonle, S 2w,
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» - Microsoft Word XP screen:

Lo AJIANG J§ o s w il

e Bl ensySEURE-Eoge0-¥-4-0

Insertion point.

1 Title bar.

2 Menu bar.

3 Standard toolbar.
4 Formatting toolbar.
5 Ruler

6 Task pane.

7

8

Document window.
Scroll bar.

10 View buttons.

11 Status bar.
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| Open =] 'the ;\?Cn( Pane to ¢loge
ot { ¢ OCument
e | Pane. Yoy Screen wijj)
o 'then ook like the one

) Crants oreee sassrert

2} Document 2 - Micresoft Word

Ble EdR  Yew Insart Fomat Tooks  Table  Window
Adobe POF  Acrobat Comments

DEEaY &1V ®! - N 9% o
TmasMNewRoman + 12+ B 7 U E]E

This lesson will
familiarize you
with the Microsoft
Word screen.

Page 1 Sec 1 i LRy inl <ol

The Title bar, which is located at the very top of the screen.
On the Title bar, Microsoft Word displays the name of the
document on which you are currently working. At the top of
your screen, you should see "Microsoft Word - Document 1"
orasimilarname.



i

S Word Tha MeansBor

| & 6 tov rot ot Tok e ol e AeE ot Comets 0 X

Menu bar is generally found directly below the Title bar. The
bar displays the menu. The Menu bar begins with the word
and continues with Edit, View, Insert, Format, Tools, Table,
dow, and Help. You use the menus to give instructions to the
ware. Point with your mouse to a menu option and click the
ouse button to open a drop-down menu. You can now use
eft and right arrow keys on your keyboard to move left and
 across the Menu bar options. You can use the up and down
w keys to move up and down the drop-down menu.

The mogy

3 lesson1. doc - Microsoft Word ﬁ'equenuy

oy oy g MG
| leroRosmsOb)ect cm-a-zl -‘-8p;;,ca,- on th
® oL Ctri4X ."bono
B2 Copy @< Son th
Edit Cffce Cliphoard,,,
«%  Undo Crop Pictwre  ClrleZ 'M'
5 Repeat Copy QUMY | et 2
X QX g,
@3 Copy cke | (s}
@ offxe Cipbowrd. . ! —
[ Paze Crrk+v
Paste Special... To select an option, click on the option or use
the arrow keys to move to the option on the
Cexr ’ drop-down menu and press Enter. An ellipse or
Select AJ CtrtA a right arrow after a menu item signifies

End...

additional options; if you select that menu
item, a dialog box appears. Items in grey are
notavailable.



Toolbars :

The Standard Toolbar:

One-click on buttons to activate common commands.

DCedza8 QY ' “BY

(\2

B

New

Open folder

Save

E-mail

Print

Print preview

Spelling

Cut

QEOEES DY -0,

(4 v

o

JS Waoril

Copy

Past

Format

Undo typing

Redo typing

0%

.| Zoom

Word help
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The Formatting Toolbar :

Below the standard toolbar in your document
windows, you will usually see the formatting. This
contains a standardized set of useful command

buttons.
s TmeshowRonen v 12 + B 7 U [EEEEEE EEFE O-A-2
Times New Roman  « Font
1z - | Font size Normal . Style options
o — .
— | Numberin
B Bold i g
Italic «— | Bullets
z =
Under line +— | Line spacing
1) ="
= | Align left ;i==| Decrease indent

Center -5 Increase indent

i
I

.."l'

Align right Outside border

v

Justify Font color

i
A.

o show toolbars:
1 click on View from Menu bar.
Select Toolbars.
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The Ruler:

The ruler is generally found below the main toolbars.
The ruler is used to change the format of your
document quickly.

£

[ SRIRRE TR 2 o3 4
To display the ruler:
Click on View on the Menu bar.
view |
] Normal
F@ webLayout
ﬁ] Prink Layout
The option Ruler should have a Qutine
check mark nexttoit. If it has a (v | Taskpane
check mark next to it, press Esc Todbars >
to close the menu. "3] Buder
Show Paragraph Marks
If it does not have a check mark <~
2 N B pooumentMap
next to it, continue to the next
step. ) Hesder and Footer
(2] Maup
I Pyl Screen
Zoom...

Click on “Ruler”.
The ruler now appears below the toolbars.
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Document View"

Layout, or Online Layout.

vormal View ;

Normal view is the most often
sed and shows formatting such as

eb Layout;

Web layout view enables
you to view your
document as it would
appear in a browser such
as Internet Explorer - @

Print Layout ;

The Print Layout view
shows the document as it
will look when it is printed.

-t e —
WHou anT

)
) - "

Be BR P e e DR gw g e

Wb « « B /U BR EE®

In Word, you can display your document in one of five
views: Normal, Web Layout, Print Layout, Reading

= . - .
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MR cd « B Frg BN %
[& CRCEREE




Text Area .

Just below the ruler there is a large area called the “text
area”. You type your document in the text area. The blinking
vertical line in the upper left corner of the text area is the
cursor. It marks the insertion point. As you type, your work
shows at the cursor location. The horizontal line next to the
cursor marks the end of the document.

< Decument! - Nicrosoft Werd

B B VYew juet

Fgmat

Ldckr POF  Acohat Crewrats

Jecs Tihle Wrdon b

DadpyE 837V " @ > -
wehewroien <12+ B 7 U [E]E ZE®E
lﬂﬁ t 2 00 4 8 2NN

LEICEX)

L
MOIEXT

S 3

1!
)

Exiting Word «

To exit Word:
1 Click on File.

2 Click on Exit, which can be found at
the bottom of the drop-down menu.

Sud e
L ymmeeMevior it s

2L Whcrvedt Word 59 Tatoriad dec
30 0ceelt wor 803 Tatend

LE98 3 200N Wordesrond, dx
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Entering text

Objectives

By the end of this chapter, you will be able to:

Enter text.

Save a new document .
Close a document,
Exit Word.



.

RS Woril

Type in your text and you will see it appear on the page
of the open document. Unlike typing on a typewriter,
you do not have to press the “return * key at the next
line. It doesn’t matter if you make mistakes, as you
can edit your work at any point, deleting text or moving
itaround the page.

TYPEOF PATA: 1 4

Picture. )
Text. : 2 '
Number.

Symbols.
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Create a new document with
Word:

To create a document you must open the Word
windows.

BEFORE YOU START —'1 |

Open a document b i
o . Yy going to the fjl
selecting new. Then double-click Olne S o and

: the b
i document icon on the toolbar. ek
\ :m
O e
e o
:..u_:mm»u-m-o s ng
Deélou s 7 a e s> -0 °
Tofadoen o1l « B /J F B® SE0Fw 40 ¢ g)se

Dowere Dossarr , = = ¥

When you open a
document or start a new
document the cursor
always appears at the very
beginning of the first page.

Nt ) W o i -

Move the cursor to the point where you want
to start typing. The pointer shape indicates
how the text will be formatted, double click
and then start typing your text.
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In word, text flows or ‘wraps’ automatically onto
the next line when you reach the right-hand
margin. You only need to press the return key to
start a new paragraph, or when making a list.

w4 Document1 - Microsoft Word 4 E‘T(

fle Edt Yew [nsat Format  Joos Table Window Help  Adobe POF
Acrobat Comments

NEedat &Y SRR R S
TimesNewRoman v 22 ~ B 7 U %5 =1
Bnopenror Opcreateror , L L W |

Welcome
Hessian, MNora
May, Mohamed, and Mustafa
.Mﬂ...ul...,...2..‘....,.......4...,...5...,...m T
l B[__J QI g
Page 1 . .
Welcome-y
; Hessian.-Nora | -
: May.-Mohamed.-and-Mustafa -q .
~ ¥
s @] 4| | »]

showfHide |~ buttop




To insert word (words) between existing
text:

A Document1 - Microsoft Word

B £t vew ket Fomar Jok Tile window Hep Adohesor

Acrobat Commants x
DEEaIY RV “8 - @0 7T - 2
Tahoms # - BJ7 U EEEEF®E QO 2
Tp openpoF Bpcresteror | =W

.

Lol

; 1Fyo to practice getting help, you can
. work through this exercise, which
demonstrates two ways o get help

.
o
s

If you want] to practice getting help, you
can work through this exercise, which
demonstrates two ways to get help. |

|

R

JS Waoril
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u’l\\ Waord To delete error word (words) for existing
tex*: A Documert!  Microsefl Werd
G [t Yow Juot Fomat Insh Tk Wndom Lop  AdchePf
Arebat Comments x
Nedey SR Y B oo @M 9 e %
Taboms N R U[EEz=ew g ¥
Bopen ook ERCraskerte | T W W
4 B T TR N T |
Using the 5 1
) ackspace s If you want work] to practos gattng
R helo, you can work through ths exercise,
k ¢ )’ to d ¢ l et ¢ = whch demorstates Two ways I ;-l : :
errors to the | iy °
left of the LR 3
CUTrSOT . 2000 1 o | n At int Col 37 Q
. M. SUR PR T -L‘
Using the delete key § | |
to delete errors by _ 1 you wart work t praction guting
& s - v ke, you can work through ths eartise, ‘
clicking and dragg,mg : okt e -
the mouse pointer 4 beb .
over an area text to
hlghllght it, then [fyouwantnopractjce getting
prcssing delete. help, you can work through this exercise,
which demonstrates two ways to get
help
Pressing [Fgy
delete
type capital letters: -
L m&g 01 173 ) « 5 AN -
U
To type a series of capital YELCOME 14 CAIRO
aps Lack letters, press the Caps lock 2 "
key before type letter. 2332

To type a capital letter, hold X
down the shift key and press . Hagyy dxy
on the letter key. IER]




Type this text :

upper left corner of the text area is the
cursor. It marks the insertion point.
As you type, your work shows at the
cursor location. The horizontal line
next to the cursor marks the end of the
document. If You have completed,
save your work before exiting.

Save your document:

Any new document should be saved as soon as possible
after creating it, this is important because sometimes a
computer’s screen freezes and you have to exit the
program without saving your files.

BEFORE YOU START

To save 3 document for the first timef

Click on file from menu bar,

Or shortcut Ctr| + .

R

U Waril




i

RS Woril

4 Document? - Microsoft Word

Ble Edt Mew [mert Format Tools Table Window Help
Adobe FOF  Acrobat Comments

DeEoY &S0V B o-Q T 5% -
TesNewRowan + 22 « B 7 U (@& = .2

x
»
-

Youtype your document in the 1ext area The

blnking wertic al line in the upper lefl comer of
the texd area 3¢ the cugsor It magks the ingertion
point. As you type, your work shows ot the I

= cureos location. The horzontal linse next to the s
~ cursor matks the end of the document. If you *
have completed, you would save your work °
I before exiting ¥
LR SCIE T [ »
Page | Sec 1 i AL 1" ini Col 46

1 Click file from menu bar. J [&
2 Choose save. * o Shio
@ Qpen... o
Close
& Open POF
o e Cirkts
he first time you save a document,
e save as dialog box opens.
Joopn L Sunmr s« QB
2 &=
R
=
)
Tt
=)
= e 0| e
P DO g Setmant (% o) - Const |




1 Savein:

Sevep: [ (L) My Documents

Click the arrow to the
right of the panel i
you want to choose
different location my
documents is a good
place to store files.

2 File name:

L My Documents

[} Desktop
o My Computer
) Abeer's Documents
) Shared Doouments
M 3% Floppy (A:)

< Local Disk (D:)
o KINGSTON (E:)

& My Network Places
L_) My Documents
3 werd leszonl
wJ 53-2007
) word lesson 2
FTP Lecationz

3| AddiModfy FTP Locations

Fle name:

o

JS Waoril

Fepame: ||

You must write the name of the document
Pressing delete key.
Write the name. "Text one"

Click save button.

The file name in the blue title
bar at the top of the windows.

3
S

‘ :j fext one.doc Microsoft Word
R —
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Or

To close a document :
1 Click file from menu bar, © - coan
2 Choose close.

Click on X from menu

Closing your document:

155

& Qpen. Qe

2

[ o

- 2 Choose exit.

Or

(Pl (B Wew fuert Fomet Jods Tl Window teb AdohePOF m:%

la-l -

=
Seve s

1 Click file from menu bar. g sweswerss..

] sevy.
0 Censror
Versons
Wel; Poge Preview
Page Setrp. .
[ Pt Pregew
& o
Sand T
Properties

Cire s

L G WMy Documeresitest oow.doc
< CADocuments and Settings). . \eat doc
2 T WMcrosolt Word P Tuterial.doc

4 CADocuments and Setirge). L

z

| e

Click on X from title bar
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Open a new document
Using save

Open a new document.

Type your name and what your shopping list is for.
Here are some examples:

Birthday list - Telephone list
Press Enter,

. lcle T—
Type your list. Phone g,

‘ . 455
Press Enter after each item. N"’d 337% 89 866
MUSsun 556 644 g
Sa\e Jour work, save it by name of your list ;™" ”66”1 /
ar"" 3’5779)

’ - E - . - u L) L u L Bl - - 3

D ( )Select Microsoft word:

\/‘ ( )Open file menu.

( )Select new.
( )Open start menu,
( )YOpen all programs.

Vpa G e oo nm 0008
(E () Open file menu.
( ) Select drive d:.

() Click in save icon.
( )Write the file name.

266785

, Re-arrange
| Steps

( ) Select save.




worksheet
Close a file
And
Exiting word

Open new document.

Type your school name.
Press Enter.

List three features that describe how your school looks.

Press Enter after each item ., ‘
Save your work .
Close your work .

Exit word .

. erpen file menu.
8 Select saunanas :

5. 5. .00 0 0P BB S 6 8
P

<- U

Close or Exit
__ Open file menu-

= Select s :
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Entering text

Objectives
By the end of this chapter, you will be able to:

® Open a document .
® Modify a document .



a ' document w -
JFS Woril | ks _——— - S~
After you become familiar with the ins and outs of the
Open dialog box, opening documents is fairly
straightforward. The basic premise behind using the
Open dialog box to open files is to select a file name and
then click the Open button, or to simply double-click a
file name. To open multiple files from within the Open
dialog box, select files while pressing Shift or Ctrl, and
then click the Open button.

~4
BEFORE YOU START =

| Sell)eecr:]t a d‘c‘)cumtint by going to the “file menu” and
- INg "open”, Then double-click on “open” i
e toolbar, il

J

L

¥

e Is|jo e §
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Pomntes

o = 3

" )

L L L ([ Te=——rp wappy e e Coed |

1 Look in :

Click the arrow to the right of the panel if you want
to open the location that you store a file in . The
result will appear in the same dialog box.

\ yConel v Pl
LW, o
ey mas
U et
| ledew

=

=3

You must choose the name of the document.

Click on the name of file.
"Text one.doc"

3 Zen -
“Click on the open button




i

RS Woril

w2l text one.doc - Microsoft Word

Fle Edt Vew Insert Format Tools Table Window Help

Adobe POF  Acrabat Comments x

el &Q@A Y ® ® T 4% -7

TmesNewRoman =22 « B 7 U =|= 1= »
-

B 0 2 oz o3 s

|7 ou type your docuament m the text area The .._'
blinking vertical line in the upper +ft comer of
the iext area 15 the cursor. It marks the msertion
pourd. As youlype, your work shows of the

cursor locaion. The homzontal ine ned to the <AL
cursor marks the end of the document. If you
havs completsd, you would save your wock " The document
befoze exiling | = 3
; @& 5 4 ~ | open in window
Page | Sec | 11 AL 1* int Coli

Selection :
Character,word, line,sentence,paragraph or
entire body text.

ake sure you know how to:

Selecting a character
Selecting a word
Selecting a line
Selecting a sentence
Selecting a paragraph
Selecting all text



o

Selecting a character: S Waril

Click just in front of the character you want to select
(in this case in front of the first character in the blue

paragraph).

* Press the Shift key (and keep it pressed).
* Press the right arrow key. ;- mmg « : 2 50« s g T
* Release the Shiftkey. " i et s

blikirg venxcdl pper Wl comnt of
e Lext aren a2 the amenr 1 marke the masrtion
pout As youtype, your woek choas o the
cumcr loction. The honzontal line mext 1o the

i.. s cr mada the ool of the decanest IFyou
hew completed, you wouldseve your vork
o Mg o 2 03 e s NN exting
i |
ou type your SENRERRR: e 1ot wen The
ninkng vertion kne in the gger e comer of
= e bext ares 1 e cscr X natks the reerton
pouas As v WOk s o the .
: Famorlociice. The bl e o The screen will
v rusor neks the end of the dousnent. I you
matotorsr ol ol > resemble that
B bafors exting
i ass ol below.

Selecting a word:

Double click on the second word in the blue paragraph,
as illustrated. Now the word is selected.

Vo tyype pouw doomart o S bet et The
Nadarg weri ot 1 e e e, < ommae of
e et a0 U cses ko e zensa

-

§ 0.2 2B, | S

-

. sl Ac youltyps, yous wosk doue d b

Yeutepe you dossmert 2.0 [l e The mbmmw“.uusﬁmm

blinkig veticy e o the 0set e e of S B au ol ke doomect X'joa
s 2t aten 8 S casce 1 ovarhs e cdion f:;:up.»um o Wik

et As youtyve, jour ek hovs f the v €

e otden The boss ol o aed o (e »
“ cusdr 24788 e o of Ba dooanet [ yeu

bam compleiad, Jou wastd ey wour wack

befors extng




) ~ ol Selecting a line ;

ﬂ[{\‘ “,’" {1l Move the mouse pointer to the left of the second line
within the blue paragraph and wait until the mouse
pointer changes from an I bar to an arrow pointing
ipwards and to the right.

You are now in the
“Selection Bar”, a
hidden screen
element. Click
once with the
mouse button to
sclect the line, as

i"uslralcd.,migg".z.;-.c-s-mj

You type yous dooumest tn the text ares The
Ylinking vestical kine inthe upper Jeft comes of
61 the text area is the cusses. [t marks the msertion
poirt. As youtype, your work shows o the
cumor looation The hocmontal line next to the
ed of the document If you
you would gxve your work

w
You type your document m the 1031 area The
- g‘ vertical line i the ﬁr 1eft comer of
¥ powt. As youtyps, your work shows o the
h = cusor Jocstion. The honzontal kne next to the -
cussor magks the end of the document [f you *
NOW the bave completad, you would save your work o
line is befors exting '
selected 74 i

Selecting a sentence:

Click within the second sentence of the second paragraph.
Depress the Ctrl key and then click wuhm the sentence, to
select the sentence. =)

oL

P Qe Foen e e oo RIS

Voo type your dooussent e ez ora The

y blmbrg vertucal bne 2 8 gpper b comes of
. ﬂ&@ peegee i Fosiv gon g SR o : fhe ted wres 15 (he crsen I8 marks the msestion
pomd. A you tese, vous wock ihews & the

Tou type you doovmest e o2 oo The exsarl1cema The bosaoetd e 202 10

blabiog vedial e 3 the wpger iof comeref oxesar ks the md of the 4o namest 1520
5 the tect wses x5 the ompon [ ek he mpenian bees onmzisted, 35 vedkd e ove Tox crs
: bedorr extzg

: Soextoedal i nad (s e »

" oas packs e eod of the docapest i yeu

e coogheded oo woek e Yo ek

befone exczg Now the sentence is selected




Selecting a paragraph: Q
ALSAN

Click within the paragraph starting with the words ' To
select a character'.
Click three times to select the paragraph, as illustrated.

. ':ﬁ@ﬂg"""'l' SRR TRETRUE: RURTREEF STRTEROR SURTRLRY 1 -

You type your document m the text ses. The
blnking vertical line inthe upper Jeft comers of
the text area is the cursaee

It marks the msertion pord. As you lype, your

work shows at the curser locstion The -
honizontal kne next to the cursor marks the end "
of the ¢o If youhave completed, you o
work before exiting ¥

A

[ ]

L g AANEEEN A
It marks the mserbion poird. As you lype, your

: wotk shows at the cuesor location The i >
~ honzontal kine next 1o the cursce marks the end I~
z of the document. I you have completed, you @
: B would save your work before exting B
IR | » l

Selecting all text:

Experiment with selecting all the text within the document
by pressing Ctrl+A.

(O R R I RE BN R S

You type yom dooumene mthe text wvn The
Heling wctacal kow e (e cppes Joft comes of
he Yot aren o0 B cwee
[t marks the nsetion poe As you type, your
wukshows o Se cursor lozeten The
bozioomtal s rest Lo Do curs i ks e ond
of 2 donupwnt 1f you Bae coopinted, v
wruld sere yow waek 2efore smting
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Modifying existing text:

Double click on the word “area™ in the first
line (to select it).
Replace the selected word with “sentence”.

Vou type your dooament i €2 b

Tos blkag vetacal e 1 0

o Qo et arvn ot e csnie M ovacks the
mssdinpowt As yrodype, yorwest shoss &
(ke curser loc shon. The hansorsd fne 2oz 1

- 1o cusses machs the end of the dormaent 1fyou
tawe congieted, you wodd save yow wark

befoee sxtng

befocr ting

Use the undo, redo command:

Using Undo to reverse your last actions

- Click on the Undo
button on the
7Standard toolbar,

Click on the Redo
button on the Standard
toolbar.

posnt Ag you Tee, your ok shows o O
cursof Joouson The bosmoatal e ez 1o the
cusor marks G end of the docurwst 1f you
havs comgleted yos woudd save your sark

Fortype war St 1 e i petierd
Toe tiekeg meed lew 2 D 19pe b coener
of Ratet ere s e ctns Naaxhs &
etk pand As Y e, R WUl dows &
Qo ez it B loaatid o el w
B cuzsor maks O ol of £ Rowarest Yywo
L cxnpinied you wedl sove o wed
e seing

il
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Closing your document
To close a document : el
1 Click on “file” from D .. i
menu bar. e o
2 Choose close.
o Click on g from menu
[Toe [e® yow pwet Fyme foos Tobhe wndow teb Adbere Accbarc: a]
s & ’
Exiting word 1 .
To exit a program: - bl
1 CliCk On “ﬁle” from 45 Saveas WebPage..,
menu bar. B vk
2 Choose exit. o

Or you can click the save  v.rummeven
button on toolbar. Page Setp...

Or shortcut Ctrl + s ;::f:w

Send To

Froperties

1 Gl WMy Documentsitest one.doc
2 Ci\Documents and Settings| .. .|text. doc
3 C:L. AMicrosoft Word XP Tutorial.doc

4 C:\Documents and Settings! ... |1
Or L l

Click on from title bar

Ry

2B text one.doc - Microsoft Word




worksheet

Open an existing document
Using save

Open your telephone list ,

Add more items to your telephone list .
Press Enter. ’

lcleph ———
Type your list. n"m::::";:’ i '[
. 3966 !
Press Enter after each item, Marim Hu.\‘samf-;’:“ $55 |
Save your work, using. ,)
Save icon. i
)
= Y ( )Select Microsoft word’
\/‘ ( )Open file menu. .
. ( )Select open.

g ( )Open start menu. !
2 ( JOpen all programs. -+

( () Open file menu.
_ g ( ) Select drive d:.

() Click in save icon,
() Write the file name.

Re-arrange
| Steps

; ( ) Select save.
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worksheet

Use undo and redo

Open a new document.
type the first name.
. n -
Change the font size. ) v
Change the font.

Underline your name.

Change the font colour of each letter.
Click edit -undo.

Do this task again but use the icons.
Click edit -redo.

“v qu 2 D T T T

N

(Count how many
clicks it takes to get
back to a blank page)

(Count how many
clicks it takes to get
to format again
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Formatting text

Objectives
By the end of this chapter, you will be able to:

® Make paragraph.
® Align paragraph.



Paragraphs are the basic building blocks of any
document . Paragraphs can include any amount of text
and graphics, or any other item, followed by a
paragraph mark or break. Paragraph marks store the
formatting applied to each paragraph. In this chapter,
you will learn the fundamentals of paragraph
formatting in Word. The paragraph ends at the
paragraph mark. Thus formatting for a paragraph is
held in the paragraph mark at the end of the text; delete
that mark and the formatting for the preceding text is
removed and replaced with the formatting held in the
next paragraph mark.

R

ASAV




=l Paragraphs :

RS Woril

Standard

about the

‘icon.

(L

BEFORE YOU START

*Type the text below .
- Going to the toolbar and

Each time you press the Enter key, Word begins a new
paragraph. Click on the Show/Hide button on the

toolbar or press Ctrl+Shift+* to display the

paragraph marks. Press the Enter key several times, and
you’ll see Word insert strange little backward P icons,
with the semicircle at the top of the P filled in. These are
the paragraph marks, and they store the information

paragraph.

then click on Show/hide

Paragraph marks store the formatting applied |
to each paragraph. In this chapter, you learn
the fundamentals of paragraph formatting in
Word..

The paragraph ends at the paragraph mark,
Thus formatting for a paragraph is held in the
paragraph mark at the end of the text; delete
that mark and the formatting for the preceding |
text is removed and replaced with the
formatting held in the next paragraph mark,

-
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4 Docwmentd - Mlerosoflt Word

O C& Yew [oet Fgma Joob Tl Wywow kb
Adoho POF  Acrobat omments

»
DSy RY "8 «- S =0
Yerme Ao Boman » 18« nlu;‘::v! e .2
‘mqﬁ-.g»-zu-_-'--nls mj
= | Puncgh malks fow the foentine aspled b each

: paragraph Inthas shugoen, you Joam e Bondusnt Jbs of
: Pl Sandtay m Wod
- Pcrograph
~ The paagnpit ends & the paagaph mark, T toamatting
- far & pangragh o beldd inths paesgraoh murt o e snd of
-

; e tart dadete vt made and B Bunating for the
- preceding bt » semomed wd spleced wih e Hondtag

- Bald I e ext paragy @A nadk
Iﬂ‘l «
Fage 1 Sec 1 mn AL ne ol

Click on the Show/Hide button on the Standard toolbar.
Or
Press Ctrl+Shift+* to display the paragraph marks.

S RRTE CERV TR SRRYRE SRYEY ST AR ST T 7
-

Paragraph marks store the formatting applied to each
paragraph In this chapter, you learn the fundamentals of
paragraph formatting 1n Word

¢ The paragraph ends & the paragraph muek. Thus formatting
T foravarserach iz held in the saraaranh marc atthe end of

—Jung for the
L %"""'1"""'2“""‘3""""‘""' e B ~ lwith the formatting

=ad)z |

Paragraph marks-store-the-formatting-app lied4o-each: _j'_ | >l
paragraph J[n-thus-chapter, your learnthe-fundame ntals-of

paragraph formatting-ia-Word §

1

The-paragraph-ends-at-the-paragraph-mark Thus-formatting: 1[
foraparagrapheisheldinthe paragraph- mark-at-the-end-of

the text, deletethar mark-and-the-formatting-for-the: | paragr
precedingtextisremoved-and-replacedwiththe-formatting:
held-in-the-next-paragraph-mark §




2~ Wl Paragraph Formatting:

. 5
SV You can apply paragraph formatting using styles, which
are in effect collections of formatting. When you press
Enter to start a new paragraph, that new paragraph will,
in general, contain exactly the same formatting as the
previous paragraph. There are some cases when this
won’t happen, though, some styles may be set up such
that when you press Enter, a new style, with different
formatting, is used for the next paragraph. For instance.
a heading style may be set up to automatically begin

working. aa apv\‘i'\'
’ You \' g ¥ alP
Alignment Type Button : pafdl, usiod |
cormat the
‘\?:\‘\‘\0“5 O“\'\n v
= | Align left (mdt
— T o g
— \00\“‘“ -
r::’“ 3ligns with the 1o = Justify
ma:ggi':' :nd the nght Ta
'S draggeq aligns ;i
'Sthe defayt gmn;h's the Ief? “;’"’ fJOth‘

= Center

Text js Centereq o
®en margins, Left 29N, and the




- Select all text. Q

- From formatting tool bar . RS Waoril

Align left ;

A R R EE R SRRy TR TERT EEr TERT ERE SERFRRD -
12

Paragraph marks store the formatting apphed te each J
. paragraph In this chapter, you learn the fundamentals of

paragraph formatting in Word

Center :

L"‘g.......l.....‘.z‘......3.......4.....A.g.......;.l
2 {

- Paragraph marks store the formatting applied to each J
= paragraph In this chapter, you learn the fundamentals of
paragraph formatting 1n Word,

1

Align right -

. %--.|~-.|---|.--2...|.-.3...|...4......- crvanr e 8

=~

=
. Paragraph marks store the formatting applied to each
: paragraph Inthis chapter, you learn the fundamentals of
: paragraph formatting in Word

Justify :

%-..,...’...,...2.......3“.....4...,... “e

L

Paragraph marks store the formatting appled to each
* paragiaph In this chabter, you leara the fundamentals of
. paragraph formatting 1n Word.

R R



Adjusting line spacing:

]SRN (1 B The line-spacing feature in Word begins with automatic
spacing, and with this feature, you can increase spacing,
duce spacing, permit extra spacing for a large character
or superscript on the line, or even control the spacing
actly. Spacing is measured in terms of lines. Normal
text has single spacing of one line, but you can choose
from several line options or even specify line spacing
based on points.

, cing
= Line SP°
+=— OP‘\’\O“S
Line spacing: Single 1.5 Lines
Line-and-one-half
Double Single-line spacing. (Line |  spacing (an extra half-

Double-spacing height automatically | jine of space between

specify in the At box. All lines
are exactly the same

height, regardiess of the size of
the characters in the line, Word
doesn't add extra spacing. Note
that some text may be cut off if

enough space is not available.

Multiple

(an extra full line of | adjusts to accommodate | jines),
space between the size of the font and any
lines). graphics or formulas in a
Exactly )

The exact spacing that you At Least

At least the spacing that
you specify in the At box the
line won't be shorter than
what you specify, but it may
be taller because Word will
add extra spacing for tall
characters,big graphics,

Multiples of single-line spacing, such as triple (3)
or quadruple (4), as specified in theAt box.
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1- Open format from the main 1=

menu. At 9
2- Choose paragraph. ?”’W
3 Bulets and Numberng. .

|
3- Choose from

“Line spacing”

A Single
B Double
C 1.5Lines

cgeee

LR

RS T

PR

)

‘e dﬁj

Paragraph marks store the formatting applied to each

paragraph In this d\*m, you learn the fundamentals of
paragraph formatting in Word

i

E%---u S LR RN 2""‘"3"""""""'5"""'&'3
B

Paragraph marks store the formatting applied to each
paragraph In thus chapter, you learn the fundamentals of

paragraph formamng 1n Word

,g......r|‘..-.-<:--~. S ARER LT IR TR

Paragraph marks stere the formatring applied to each

-
paragraph In this chapter. you lean the fundamentals of

paragaph formatting in Word
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+ Paragrph marks store the formatting applied to each J
- paagaph In this chapter, you learn the fundamentals of
. paragraph formatting tn Word

E AtLeast

‘ﬁ.“,...p......z...,...)..A,A..‘.......s....... a
. m& iy n‘% %’?‘»‘3 wam %&%&?m“%%

© paaph lormathng 1 Word

=  paragraph Io this chapter, you learn the fundamentals of

~ paagraph formatting i Word

.-0wie
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ﬁllgning text

Type the following words * right- h and side™ -
Click on the align right icon.

Open a new documen

press on enter.

Type the following words * left-hand side™.

Click on the align left.

Press on “Enter™.
Type “center™-

Click on the center icon.

Save your work-

Print your work.

Close your file, Exit word .

o bar

R

U Waril

=
EE

T EEERRS

() Select the type of .
the alignment

. )Select text \
»( )From formatting .



\
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ormatting text

bjectives
the end of this chapter, you will be able to:

® Create lists.

® Modify lists.

® Format lists.

@ Customize your list.




" reating Lists:

RS Woril S organize lists in a document, such as lists of events,
names, numbers, or procedures, Office Specialists you can
format the information in a bulleted or numbered list. A
bullet is a small graphic, such as a dot, that introduces an
item in a list. Where the order of items is not important, use
bullets. Use numbers instead of bullets when you want to
emphasize sequence, as in a series of steps. If you move,
insert, or delete items in a numbered list, Word renumbers
the list for you. If the items in a list are out of order,
alphabetically or numerically, you can sort the items in
ascending or descending order using the Sort command on

the Table menu.
= g_—l
3 — T —

B —
BEFORE YOU START :
MNumbering
Bullets

Type the text below .

‘Going to the toolb en cli
gNumbering icon” click on

“Bullets or

Decipher all those line spacing to read between
the line:
Single spacing.
1.5 lines.
Double.

At least.
Multiple.
Exactly.
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-
E 83|

Click on the bullet button on the Formatting

toolbar. g

Or k

I On the Format menu.
2 Click on “ Bullets and Numbering”. fyma ,1

A Foet.,
5 Dwagah..
The Bullets and Numbering i ulstsand Nrberng..
dialog box appears
Bivind | petend  Outhe bl | v |
n ] »
m .- “" »
vy | gl | et | ot s
Seten t v | 10 My “ rnairg? | ety
fusmming | L0 i ) ey | eeeer
” - '
- ] cew |




RS Woril

e D R M \Souty ! O | v—
et | 0 eyl Avwamgl | ey
wmeant | 11 weay s 1 ey | ey
£ |
.
Select bulleted Select npmbered
W
o ‘ '
. . : o ] :
u - ] P .
. L] » . ) .
] ® ] i
. " » L |
‘ ' ’ ‘ ‘ ; "

| Select text.
2 Click on “Bullets” from formatting bar

Decpasr al those (e spaceg 10 read
betwesa the hnes

* Single spacag

ormes Bullets

» Doukle

* Atlesst

o Mutgl]

o Exactly




| Select text.
On the Format menu .

Click bulleted .
select bulleted.

Click on “Bullets and Numbering”™.

R

JS Waoril

SN bW

click on “OK” button.

Deciglier ol oe line spac g b sead
J¢fwrcen D ey

1

5

Select the Setubal

Adobe FOF  Accbat Comments

NeEdo SV

TermeMowPomes - M4 - B J U
2

w.
e Edk  Yew Jroer Fgmat Jools Tgble Window Lelp

| <.

R TR EEE TR TR Crp)

bulleted. s | . . .
‘i - * » v

x
. % - »

_aEe r

hetween the ines
Sngle specng
Lines

Double

At least
Mulriple
Escacty]

Ehbbee

Decipher all those line spacing to read

o | 1 AL 38"

e Culio
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U Worid I Select text.

2 On the Format menu.
3 Click on “Bullets and Numbering™.
4 Click bulleted.
5 select bulleted.

6 click on “"OK” button.

Decipher o those Lo apacag lu cead

e 1wven Be ke ey

5 Bl | et | e iatees | o S |
- - -
Select the Setubal el = . .
bulleted. " . e
- « > v
‘ - * » v
- . - v
» _ ”  ——
2 Dociment - Microsaft Word [ (=115 4 -
| Connt
Ble Edt Yew [reert Fome Joob Tghle Window ek - -] :
Adobe POF  Agobat Commants
NeH=m SA ¥ B -
Tewctowbonmn - 24~ B 7 U = = ==
d 108

0K

_'.mm_"’"-"”’??ﬁ.‘f.’.i..'.'.'T,’.f.,.A 25< D aridve

Decapher all those line spacing to read
bhetween the lines

.

< Single spaang
% Lmes
% LUouble
4 Atleast =l
< Multiple s
<  Exactly v

L\

e

Se. 1 i AL 38" e Colo
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Select text. IR TV
On the Format menu- S Waril

Click on “Bullets and Numbering”.
Click on “*Numbered”.

Select format of number.

6 Click on * OK™ button.

B WD

Dt ol thooe low sparmg o read
yrtwesn the Looe

1

A Fort..

=1 Baragraph... ‘
= Bulets and Nunberig... 37

5 Select format of
number.

B Oh o= el Pone Inh Togh e e J

A WOF  Aarvben Deen -

RIS 8A? | e S -

b « e B/ U BEREEIT ®®?

o - ""'.'3. R i

'I Decgphey o ose lew maceg o tead -
between Be bnee

$
Ll A Gagle spacng

H B Low

i € Owsbie i
Tl ‘!’:\nﬂ rh
- N v
-aEs
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For emphasis, you can change any bullet or
number style to one of Word’s predefined formats.
For example, you can switch round bullets to
check boxes, or change the letters in Roman

numerals from upper case to lower case.

Picture... 1'

Customize Bulleted | ist

=%

m«.hgqxu
ciREEE
You can also T BT
customize the list | s oo
style or insert a e I
hoicture as a bullet. Y s oy
) T ml -n“-j
—— |3
Qharacter.-- O Sem—
, N —
You can also
customize the list =] s |
style or insert a
character as a
bullet. [ T— )
e
W clclolclelolalalelalalalelala
ojv]*i= clzialelwlaledde] T o4
+1"1: wlolelvlmlal=]l.. ]! da
b B B3 P BN K0 O dsiSisicisiale o

GOoOEDLEooREEEnnO0n

P e o [T

-

e |

- [
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Moo ¥
se Customize, .,  :
0 mogig ® dialog p
ust 11, fo at
Omize yo, list. and

You can also
2 customize the list

start value.
Sart at: Ii - ‘

humber style: 2

[pBC .. v

You can also
customize the list

To see th 3 style number. ‘

result
Number style:
- 1,23 -
I, II, I, ... -
. , 8, i, .
S— A,B,C, ..
- ai bi cI |
w2,




Automatic

EENECO
HEENED
EEENT

More Colors, ..
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Formatting text

Objectives
y the end of this chapter, you will be able to:

® Change font style.

® Add effects.

® Change font.

® Change font size. I

® Change font color.
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Changing the Look of Characters Microsoft The text
you type in a document is displayed in a particular font.
A font is a complete Office Specialist set of characters
that all have the same design. The fonts that are
available vary from one computer to another. Common
fonts include Times New Roman, Courier, Arial.

You can vary a font’s basic design by changing the
following attributes:

@ Almost every font comes in a range of font sizes. The font
size is measured in points, from the top of letters that have
parts that stick up(ascenders), such as h, to the bottom of
letters that have parts that drop down (descenders).

@ Almost every font comes in a range of font styles. The
most common are regular (or plain), italic, bold, and bold
italic.

@ Fonts can be enhanced by applying font effects, such as
underlining, small capital letters, or shadows.

’A range of font colors is available in a standard palette, but
you can also specify custom colors.

@ You can alter character spacing by pushing characters
apart or squeezing them together to achieve a desired
effect.




Changing the Look of Characters tiiS " _ ¢

After you have selected an appropriate font for each A SAV
element of a document, you can use these sets of
attributes to achieve different effects. Although some
attributes might cancel each other out, they are usually
cumulative. For example, The Garden Company might
use a bold font in various sizes and various shades of
green to make different heading levels stand out in a
newsletter. Collectively, the font and the attributes used
tovary looks are called character formatting.

BI U
/|

Type the text below ;

‘ th . i

/ nput /output storage:

When you enter new data, the Reystrokes must
be stored unit the computer can do something
with the new data. When you want data
printed out or displayed, it must be stored
somewhere handy first.
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Inpat | output dosge

When you exter new cata, the keystiokes must be sord
- it the compater cxn 80 somethang wath the mew dats
- When you wasd data prinded et or dapluyed, it yat be
stond somewhere basdy flog

'.0.&‘

>

= olai>wicl
I Select “input /output storage”.
2 Click on “Bold icon”.

- ko i, the yokes st e o
nv

m:pmu&vmlqm&n&h
When yoo wee duts prined 0 or isplaged, 3 gt be
stord somerbes M7 it

I Select “input /output storage™.
2 Click on* Italic icon™. §

lagw cotp mearge
R N S

1-. RS

b

—t—
4 m PR aer e WJebirarey N M

2

L5l

(=

lqll outpul storage:

Whea yon enfer new data, the keystrekies nust
be stered wut the sougater can do saething
vath the new data When vou want data
prunted omt or desplayed, o must be stored
semenhere handy frd]

I Select “input /output storage”.
2 Click on“Italic icon™. 1

o+l

-g
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== Times Mew Roman j

A range of font
colors is available in
a standard palette,
but you can also

specify.

BEFORE YOU START

Open the file of the text bellow.

Going to the toolbar a i
o nd then cli
Size and font color jcon, S Font ik

Almost every font comes in a
22 ~ | range of font sizes. The font
size is measured in points,
from the top of letters that
have parts that stick up .

Type this text :

I nput /output storage:

When you enter new data, the Reystrokes must
be stored unit the computer can do something
with the new data. When you want data
printed out or displayed, it must be stored
somewhere handy first.




i

e | ‘Select text.
S Waoril RERRHINE

i

P P T ..Bmg

When you =ntes aew data, the keystsokes must
©e stored uast the comguter can do something
wih the new data When you want data
pnnted o1t or diplayed. it mastbe stored
somewhere handy first

2 Click Font from formatting bar

Times New Roma {
Click
e [ -

T Tahoma i’
ip Bharoni TN TIAR

* Allegra BT 3

T Ak e mayl

T Angn e 3 Search for Font name using

P AngraallFC
S % Sal scrollbar.

® Arial i 4 Click Font name.

2

Input / output storage:

When you eater new data, the keystrokes must

be stored unit the computer can do something

with the new data When you want data
phinted out or displayed, it must be stored
somewhere handy first

JOERT )

‘1

caReen

" Qo »i4




| Select text.

2 From the Format menu -

3 Click on “Font™.

4 Click on “Font tab™.

5 Select a new font “Poster Bodoni BT”.
6 Click on * OK * button.

e

JS Waoril

. s " ' W LR :__\_
Select 1
text Wher, v et e 4, the bepwvches st be dored

ucst e congruter cen do steething b thenew dute.
W, you wart due prsted out or dsdeyed, 1t st by
stored sonewhere bardy first

rogt | Cnagacter Spacr | eyt Errecee |
Lt bt ot - . Pav e
v Fogin
5 A change the character 10oks such as b s i e
[Foes e Rewer =] et
FOﬂf .' ) ca':;nm G
Specialist set of characters that all | Fr=iies =] pesea
have the same design. The fonts that | i ndtee e
are available vary from one computer | o =
to another. Common fonts include | | e = [ 2 [cose
1 : r
Times New Roman, Courier, and | 55" . e
Arial. e :
Font size : l_ Sample E=s

A Fane £4m nat By weruloct. B dewmns v s ore el e grevec

The font size is measured in points,

from the top of letters that have parts ) e ]
that stick up
Font style :

(bold - italic - underline

6 Effects:
Fonts can be enhanced by applying font effects, such as
underlining, small capital letters, or shadows.

Preview :
To see the result
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1 Search for font name
“Benguiat bt .
2 select font style “bod™.

3 Select font size “18™.

—_—
Latn teot Fonks Font stﬂe §¢e
[Benuis 81 ||a
Asian teot fork:
|Tnesfbnﬂmm j
:e:::l::l?onf fects I Dadie ?;—?—;—E
select * Shadow *. ."M =
" Supersorpt [ Embass
! " Engrave

[ Sal caps
[ Mcxps
[ Hidden

Input / output storage:

When you enter new data, the Leystrokes must be stored
umt the computer ¢an do somethme with the new data
When you want data pnnted out or displayed. it must be
stored somewhere handy furst

Faml

:
2

a"
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N =i (=] . lnput/output storage:
When vou enter new data, the keystrokes mmst be stored

wO rd © e the m:m do sometlung with the new data
When vou want data prated out or displayed. it nmst be
stored somewhiere handy fust

I On the Formatting toolbar.
2 Click the down arrow to the right of the Font

Color button.
3 Click on the color palette .
4 Click the Pink box in the first column of the

fourth row. 2
A
‘B Acomatic ’
The color of e |ERTIEEEE
selected word is no EENEEEEE
pink. 5:.,l,.;;

Input / output storage:
Whew you enter new data. the keystrokes must be stored

wt the 00 can do somethig wath the new data.
= When you want data printed out or displayed. it must be
stored somewhere handy fust ;
L

CR-1CIERY
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Using bold T~

Open a new document .

Click on the “bold icon™ .

Type the title of your favorite book .

Press on enter .

Click on the *“bold icon” to change the font to normal |

Write three sentences about why you like your book

Save your work .
check your work in print preview .

print your work . \

Close your file, Exit word .




werks'he.e? y
Using italic % /
Open a new document.

Type the sentences in the box below.

add three examples to each sentence in italic the first one is
for you.

Lots of people go abroad on holiday.
I eat fruit for example

I like healthy food, for example
Forms have different animals , for example
there are many makes of car for example

Add three sentences in your own.
Save your work.
Check your work in print.

Print your work.

Close your file, Exit word.

L
.
.
.
-
-
.
.
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worksheet r/;~
Using underline «ﬂ»/

Open a new document
Type the following numbers
Underline the number that are multiplies of 2.

1 2 3 4 5
5 6 7 8 6
7 8 9 10 12
13 14 15 16 17
18 19 20 22 25
Save your work .
Print your work. H \

S ERSSEE

Close your file, Exit word.

9a)....

. - E L J . »
L L 4 ~ . - L L N
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worksheet

Change font size % ,

Open a new document .

Select font to use.

Type the following and change the font size of the words to
match the meaning :

Miniature ﬂn?,e
Massive glgonﬂc

Type three other words that you could use to describe size
and change their font size to match the meaning.

Save your work .

Close your file, Exit word.




worksheet /

s
Format font - using szecfs&ﬂ/

Open a new document

type the flowing words using the matching format effect for
each .

Change the font, style, size, and color of each.

Saveyourwork. @ = s rssecssseasn

print your work.

Close your file, Exit word.




worksheet
Change font <
Open a new document .
Select font to use.

Type your class name .
Press Enter, type your class number.

Highlight your class name by dragging the I over it, holding-
down the left button and change font.

Chose font name for class name. '
ame of my class jg.
Chose font name for class number. - s:
~ dss number io.
Save your work . ber js;

Teres New Roman ') ....... ..

( ) From formatting bar.
() Select text. .
() Open font .
( ) Write the text. :

el ) Onenchoose font,, o Re-arrange

Steps

Font name for ciass name .
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Change font colour po—

% ;
Open a new document.

Type each of the following words using the font color that

matches it.

the first one is done for you.

— e \
Elephant by
Daffodil seq
Sand grass

Add five words of your own.

Now type your full name using a different font color.

Save your work. -
&l Automabic )
Close your file, Exit word. EEEEEEEE

\ Il
A )o 20 ' 0 U0 98 68 r.].ff- mme
SEEDE SN

More Colors...

() Select your color.

() Open font color icon.

() Select text.

. () From formatting bar.
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Copy, cut, and paste text

Objectives
At the end of this chapter, you will be able to

® Copy selected text.
® Cut selected text.
® Paste selected text.
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The following table shows the keys and key

combinations you can use to move the insertion point
quickly.

Pressing this key| MOVES THE INSERTION POINT

=] Left one character at a time.
@ Right one character at a time.
@ Down one line at a time.

@ Up one line at a time.

[_cmjj + [q Left one word at a time.

e [ 4 [=]] | Right one word at a time.

Home | To the beginning of the current.
End I To the end of the current line.
E 3 + [Yome || To the start of the document.

[E\ + | B l || To the end of the document.

lm ;] Up one screen.
m Down one screen.
c J+ C"ﬂ] To the beginning of the previous. Page.

cr J + To the beginning of the next page.




Copy, cut, paste : JES Ward

To save time, you can copy and paste its properties as
necessary, instead of having. A quick way to copy and
paste is to use [ctrl] key +[c] key to copy and use [ctrl]
key +[v] key to paste.

CZETD = |

'Go to the toolbar i
Jrmbontcl i and then click on copy, cut, and

Input /output storage: p
When you enter new data, the ReystrokéGs ‘

must be stored until the computer can do
something with the new data. When you
want data printed out or displayed, it must
be stored somewhere handy first.
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:——:‘ e B e - b m—d

S B W b Ty WD B e ha
- Wi e et Gt e i ey g 8 —
deed et e b

Copy text :

| Select text. e -t
2 Click on “copy button™ from
formatting toolbar.

L)

Select
text

2

B

Copy

3 Seclect new area.
4 Click paste button from
formatting toolbar.

|

Bt - owtpur stor age

Whes der swew daba, Ihe beyiroke? mus e stored
vl Whe conpuer cm 40 somethung with the new data
When you st dta pointed cue or displayed, it must be
dored scarmedere haody fet

[CRR B SRS BERU RS | ! 3!«!“.3!5

Inpes - outpiit storage
When o enfer new dats, the keystrokes must be somd

LNE the zomguser can o someting nith S new dats
" Whea you wast dea preed ot or doplaped £mnt be
sbooed socmewiere handy Led

L]
.
.
.
.
'
.
'
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
]
.
.
.
’
.
4

.
Wihen you enter sow dale the Raporokes st be Slored 8
} unt the compueer can é sometheng with % new data

.

'

: Whea you want 42z pemtad it or dplayed £ mont be H

Paste hoced soomntnre handy Lost H
q ﬂ:J. '




B0 e e e e e e e S e f— 'f
Delan ale L A tm 200,
Cuf texf: ASbten c 8- B ITUBRAR GUNN Fap. b |
. WEm—— - ¢ . Y ' P '— |
’
ror——— I
e A N YT S Rt by Snd
g T i vV .
| Select text. ! Sempeotat tnpesind 10 Mphird asmte
. Bl e .t
2 Click Cut button from
. 3 Wy s m———— - 4 e b e
formatting toolbar. : e e & g vk e e e of
‘-pu“--“u—h |
. e -y .
ek, ."
) W A" =W e - .‘
YRR T T }?
Whee you wter e G, B hovpseo b ot B shored
o 0 compvrr caa e nooiag il e wew dau
Viee you wast daa preted eut o dupliond € man be )
Pond poowes hoe bandy {10 &
Vhew poci wter teer dats, e bayenskor ao e stored E\}
08 D conpee o de nesting ol 0 e L
Vies o wast e paesed ar or dsplped, @ moum e Cul
Boed wosew bere haedy frnt

3 Seclect new area.
4 Click past button from
formatting toolbar.
Juaswes

Waeo you eater now deta, the lrvar*n mne he rtoerd
st the compater cando sometung with the pew data
Waew you waal data pracsed out of duplayed, € must be
dored comewhere bundy ra

The select text is
hide.

Waeo you camr new dea, 1 keyarokes muz 5e seed
10t the compesnr an 49 rortethung with the new data
Ten you want dats priesed ont or doplayed. € s be
mored somewbere handy frat

TR, B CEERRTS | (R TEEE RS EERRTER. )

Whem you ruter sew data, the keystrokes must be stornd
usit the cotputer can do sonething wik the ew faca
Whea you want dana printed cut o dsplaped, € muss be

4 Acged som

'llyul oulput stelage

Whea you exter sew data, the keyeroxes musnt be esored
st the comgeter can do somethung wilt the new Ssta
When you wan! date pronted out or Saplayed, € must be

Paste dored somewher= tandy fr g
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Using clipboard :

The clipboard stores up to 24 items at any time,
depending on their size. With the insertion point at the
correct position in the text.

BEFORE YOU START

- Going to the menu bar

|

Click on Edit men

%7  Undo Paste Ctrl+Z

Select

#N Find.., dertowssme
————X Chrivardonety,

— Covw ov oot 0 roflest dors.
1




B e e e e e e e e e -
TENeS LT . atTw 3=l
A omminn s s R A B ER -
o B b e ) ’ -l.. ; W
' » w - ¥
f e e e e
- ——— - -m' Ohch_an tan 02 padte
| C-“
| s
. e oy o O 0 T P
o..l . -—
- - AT W
| E!Iect text. l
2 click Edit menu from menu bar.
3 click on “copy”
Or click “ copy button™ -
Thes provan ww dea the ks e met e gand Eﬂ ‘2
it & ravteg o@ o e bt
nnx:p.o-.w?—\- ¥) UndoPasts (4l

1 wurvd pmrvies nby

Ther pr e ww dtn B bew oy wn e e weed
SR REEr Las b heaBal WM O W b
Fhoe vt dasgraomd vt « dpliped, ¢ mat be
2t rmeviey kb B0

4 click on Edit menu from menu bar.
5 click on paste .
Or click paste button.

Or click clipboard. s 3
M Adese DIy
= Sl
ol E
4 or

l.| o

‘%m s

Frmtsdd B Onw

A w Baen ta padte:
) your | curms seorsoe:

7&-' el

—

Wit yors eir nee Sa, the keyemrekas mone b 2omd
Wt the comprtar cun do sansthing with the newr dea
Whes you vewre data Jraged ot of deplired, g be
arvd pamewhury hady fert

Bt | cnstgent bexage
Wit Yoot enter tewr Sa, the eytrokess sool Be Roowd
e the comprter cin do eanething wih the new des.

‘-mmmm‘namnmh
el somzawhary hardy Gent

Input | eudput shexage

~ay

A SAVAL
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Apply Text Formatting:

You have already copied and pasted text. Similarly, you
can copy text formatting from one text selection to
another. In this topic, you will use the Format Painter tool
to do that. You just spent 10 minutes formatting the
heading for an important report so that it looks exactly the
way you want it to. Now, you need to format six other
headings in the report in exactly the same way. You could
select each of the remaining headings and apply all the
individual format options again, but that would take
valuable time that you would rather use to edit the report.
A better way would be to copy the formatting you just
created and paste that formatting over the rest of the
headings. That way you could save almost an hour and be
assurcd that the headings are all formatted consistently.

BEFORE YOU START 4 I
- Loing to open document

' Applying new format looks such as :
Font - font style - font color

To copy text formatting and apply it to another

5 text selection:

1. Select the text with the formatting you want to

copy.
2. On the Standard toolbar, click the Format

Painter button.



Open this document .

L R R
. ——
R Bre S o trve,
Smaan sm s MR BREAR O Saas ¥
. o— o . — 4 . ,—n.‘.?
| .
| Apply the following
LZ5memme | format this document :
) S Font is: “Dauphin” -
—— Fontstyle is: “bold” -
I Fontsize is: *“36" -
lape sne cup =
Wi yov s sow S0 e i ey —
EETETEY - - EEaere
arw den Whee poe weet St peand b2 o
Snlwed cmende Bred vervhee e —
Fou i 2w e B brrvsbe: st b
vt at S [TYWLY cn b medag v s
e b P v wt b prind ot
ey, § st e 21l mmewbere bady b2

| select text that has the format you want apply it

to another text.
2 click on format painter from formatting bar .

/output stogage.
eake the keystroke the 3
u enber new data, the keystrokes mas a

it the m:m o something wieh N
1ew oz When you want éata grmeed out or
displaysd, 1t must be stored samewhere Aandy fist FotutPamr'

3 Drag to select the text to which you want

to apply the copied text formatting. Ty
Input ' output storage: | pz).a Leg fo.' Po
When vou enter new data, the keystrokes must be I bc’”b P a
stored vt the COMPULET can do somethung with an.
the new data. When vou want data prmted out or
displayed, st must be stored thuxd\
o

Format Painter immediately applies the copied
formatting to the new selection .




worksheet P

Cut and paste &"/

Open a new document.

Type the following :

One A hexagon has this many sides
Three A square has this many sides
Four A triangle has this many sides
Six An octagon has this many sides
Eight A circle has this many sides

Cut and paste the correct answers next to where they should
go .
Do this activity again

using these icons. i) £
Save your work. ‘

print your work.

Close your file, Exit word.
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=
Copy and paste T{
Your best friends like the design of your “keep out” an

would like you to make some for them.
Open the file that you saved your “keep out” sign in.

Select the words.

Copy the words. Copy me
Open a new document,
i Keep out !
Paste the words.
Add your friends details.
Save your work. B ,.-..... .

Print your work. ) Open edit menu. *

Close your file, Exit word. ) Select paste.

) Select new point.,

) Select text.
Re-arrenge ) Select copy. :
Steps ) Select edit menu:




\
=

\’

MEWard!
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Using graphics

Objectives
By the end of this chapter, you will be able to:

® Add picture and modify.




i

RS Woril

Word’s graphics capabilitiecs enable you to create
dazzling documents as well as integrating content from
other Office applications into your Word documents.
You learn how to use Word’s powerful graphics features,
including choosing the right image file format, editing
graphics, laying out your documents, and creating
“Word Art” to add shaped text with special effects.

Adding graphics to illustrate your documents makes

those documents more appealing. The pictures that you

insert can come from numerous sources, such as stand-

alone graphics programs, scanned art, and clip art.

Word allows you to add existing graphics to your
document in a variety of ways. You also can create your

own graphics from scratch using Word’s powerful
drawing tools. This chapter explains how to use Word’s
graphic tools to add and work with graphics in your ,——
documents and how to work with text boxes to lay
out text and graphics anywhere you want on a :
page.

Where to Get Graphic Images ? s
Inserting Pictures into Documents Word is ¢& -
extremely flexible in how you can insert a
picture into a document. For example, you can place
the picture in-line with existing text or insert it in a text box or
table. Different techniques offer different advantages. Inserting
a picture in a text box, which you then can position anywhere in
your document, enables you to have both text and images stored
in easily movable containers. Unfortunately, the way Word
handles these containers is a little buggy, and sometimes they
won’t go where you want them to go! You can also insert a
picture in a cell of a table, allowing you to position the picture
next to text in an adjacent cell.
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Add a picture:

When you insert a picture in your Word document, that
image appears where the insertion point is located.
When you place the image in a text box, the image
moves with the text if you add or delete the paragraph
mark either preceding or following the picture.

BEFORE YOU START

/’ Open a document, you may already have a

| picture that you want to insert, but don’t worry if

' You can easily find graphics sto
red
' computer, ona cd oron the internet, -

You can insert a picture in your document in ("’
various ways:
| Use the Insert menu from menu bar.

' 2 Click on Picture command.
' 3 Choose either the Clip Art or From File \
| submenu. 1558
Irsert _
freak...
Page Nymbers..
Date and [are..

Symbal.., l

2 Nurber .. 1
— | Bctue | (8] cpar... 3
7 Text box ' & FomFie...
: 'al W rhypedpk.. CUHK | B3 From Scanner or Camera...
- s

| ¢fs Qroanization Chart

Click on the &) tewirowng
Picture button on @ Autoshapes
Picture toolbar. Al wordart.,

B chat
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Put the cursor where you would like to insert the picture.
S TR S der i R I L IMW

.|

Luput entput storage
Whea you ester new daz the keystrekes mus be mored

amut the competer can de something et the new dats
Whaen you wast data pranted 0ot e duglaged, £ oot ke
stosed somewhere handy fest

| .
Ereak..
Page Nysbers. .
Date and Time..
| Insert Clip Art
" o V@ comn. 3
Text Box * [ FromFie., © Insert Chp Art v X
" 8 w; QK B2 From Scanewr o Camera... Search For
lafs Qrgsnization Chart Search taxt:
&) tiow Dravang
@ Autoshapes
» foing : [ean] [
i chet [ Other Search Dptions
o Searchin:
B I BT = [y SRS oK }
_ t P Al colections »
et Resuks should be:
ﬂ;--.?. -::: “ mm” i
O S B e
ﬁ--u.—-‘-*t-h ae
- e -
L L d
. = Sec also
(& cip Organizer
e
o g womh & cips o
o @i @ Tips for Finding Clgs
'0.0.':. -'-" :3_
foer [ Apmams . AOOHE4CLE SodoA-ETHE D



Insert Clip Art v x
Search For
Search text:

Other Search Options
Search n:
Al collections v
Rersubs shindd b
Al media Fle types ;9’1

See also
i Cip Organizer
O Chps Crdne
[Z) Tips tor Finding Chps

See also
B Cip Orgareer
@ Cips Crine
@ Tips for Finding Clps

v
Lol
[ g e s |
+
.
| S )
‘ .
p—
| ! .
.
-
- -
| .
| L S

[reest
=dn Copy
K Delete from Clp Crganaer

Input | sutput storage:
When you exder naw date, the rokes muist be stord
unst the compeder can do comething with the new date
When you wast data printed ot or dieplayed, 1t swuet be
stored somewhere handy fine




.

RS Woril

Modify Pictures :

After you insert a picture, you can scale or stretch it to a
smaller or a larger size by some percentage, Either
proportionally or non-proportionally. You also can size a
picture to the exact desired width and height, or you can
crop away parts you do not want to display. Resizing is
useful when you need a picture to be a certain size.
Cropping is effective when you want to show only part of
apicture. You can resize and crop pictures using either the
mouse or a dialog box.

BEFORE YOU START

?pen a document,
nsert picture from Clip Art -
Select picture by click on jt.

r—

Eadoss #LSEEHY/

When you click on a picture, the picture bar
will appear.




R .. & d C 2 P'j- S g !
esizing and Cropping Pictures S Ward

vx¢gaud% h

e ey :u-.ub,ﬁ.-l-n- b sornd

-r&nbmmhwm
Jors onat data prerted 08 o Byt £ et b
oo ady fad

D
‘-l.'.‘
ey

You can resize and crop pictures using either the
mouse or a dialog box.

Toresize, however, the picture’s proportions change. Move
a handle on the left side of the image, for instance, and

you make the image thinner, but its height won’t change.
Cropping a picture is very similar to sizing it.
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Adding Borders to Pictures:

You can add a border around a picture or a
drawing in several ways. Click the image and
choose one of the following methods:

1 Choose the Format menu.

2 Choose Picture .

3 Click on * Layout tab™.

4 Click on “Colors and Lines”.
5 Clickon “QK* .

T

-

|Gt ek imme || | ot oy

-

TEERIE L
- » . - r——
. - 4“
- :;---.p:-r
o cremrire Kl L. s e
e v ovpund 0w o Splond 1 a0
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1 Select the picture you want to crop. ASAVar !
2 On the Picture toolbar, click Crop .

You can crop any picture except an animated GIF picture by
using the Crop command. To crop an animated GIF, trim the
picture in an animated GIF editing program, and then insert
the picture again. :

=

3 Position the cropping tool over a cropping handle and

then do one of the following:

-To crop one side, drag the center handle on that side inward.

-To crop equally on two sides at once, hold down CTRL as you
drag the center handle on either side inward.

-To crop equally on all four sides at once, hold down
CTRL as you drag a corner handle inward.

4 On the Picture toolbar, click Crop
to turn off the Crop command.

Note You can undo a crop at
anytime before saving the
picture.

@&

Reset Plcturel




e worksheet ,/\
Inserting clipart art =/

Open a new document.

If you have a pet type: “my petisa”

“The kind of pet I would like is” -
Press Enter.

Insert a clipart picture of the kind of pet you have or would
like.

my petisa

i}

The kind of pet §wvould like 18

Save your work. n

Close your file, Exit word.




wapter (9)

Using graphics

Objectives
By the end of this chapter, you will be able to:

® Add word art.
@ Add autoshapes.
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Creating Word art:

When you want a fancy text banner that you can’t seem to
create with font attributes, you can use Word Art to create
special effects for your text. You can make Word Art text

appear curved, outlined, multicolored, shadowed, or
three-dimensional. To create a Word Art object using
existing text in your document, you select the text, click
on the Insert Word Art button on the Drawing toolbar,
click on style in the Word Art Gallery dialog box, and then
click on OK. The Edit Word Art Text dialog box appears
with your text selection highlighted so that you can add
further formatting to the text. Click on OK inserts the
Word Art object in the document at the insertion point.
Selecting a Word Art object displays the Word Art

toolbar, which you can usc to edit.
BEFORE YOU START '4
: 0 1o open new document. :

Type the following text.

( 6 In our school we are happy
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1 Click on the page roughly where you want your word
art text will appear.

2 Click insert menu from menu bar,

3 Click on picture. [T

4 Click on word art. Svereprien

e

Choose word art | [«r;.-. rww

[

WorcArt

N . IR
AL

Your Text Here

“5 Write the text below. ”
In our school we are happy |

J#¥NgY 807 L S
Ao s« R TR BRERER |

Tt our she are [;Appy

>
- TN

our sheool we are
m

“aEy,
e L ptens TOHENLC LA M deran
2 e rm e g A




i

RS Woril

Creating Autoshape:

You can use Word’s drawing tools to add shapes (drawing
objects) to your documents. Office Specialist Drawing
objects can add interest and impact to your message. Popular
drawing objects include ovals, rectangles, lines, curves, and
Auto Shapes more complex shapes such as stars and
banners.

To draw a shape, you click on tool on the Drawing toolbar.
Word then displays a drawing canvas. You drag the pointer
across the drawing canvas to create a drawing object the size
and shape you want. If you add multiple objects to the same
drawing canvas, you can size and move the drawing canvas
and the objects it contains as one unit. Tip You don’t have to
use Word’s drawing canvas when creating drawing objects.
If you prefer to create them directly in your documents, click
on Options on the Tools menu, click the General tab, clear
the “Automatically create drawing canvas when inserting
Auto Shapes™ check box, and then click OK. By default, a
drawing canvas has no visible attributes of its own, but
because it is itself a drawing object, you can apply borders
and shading to it just as you can to any other object in Word.
You can also manipulate it by using the tools on the Drawing
Canvas toolbar. Those tools let you fit the drawing canvas to
its contents, expand it, scale it, and specify how text should
wrap around it.

AutoShapes ~ l
BEFORE YOU START

Going to open a new document.




1 Click on the page roughly where you want your word
art text will appear.

2 Click on Autoshapes from draw bar.
DCEAB4CIE >-L-A-==8 "

m—— |

S

|Dwv°l« Augoshapes * .

& e ' 1 3 wres , | 2 % e :
ws] Connectors o] IS Coprectors 9| a>l Copecicrs '.].
o e Y [ B
'@J et Shapes O | gask Shapes ’ %»;ﬁ;’l; oo
B, Bock frows ’ E Block Arrows » Za Dwwhat 4 L-" «_)'_) ®
| Zo Howchart ’ T Fowchat - e’?"’“m"f?cﬁﬂj
‘ B s and Banners » e s and Barvers » % s T RN
¥ : (DO O
¥
A toShapes ~ M‘“W'l ‘ |
‘ g ——— -
g’: Lines l ’ r 2 e ’ 1
o] Cogpnectors 2 L4 o] Coppactos ' [
i 10 Bask Shapes ’
asic Shapes 3 B : r
? & 4 R Block Arrows . g n
=, Block Arrows ’ 12, Bowhart » ‘;' TR %
s - o - by
Zo  Elowchart 5 » B Rers and Banners » ﬁ.-:@zéﬁ
,R} Calouts o oy o %
b Stars and Banners®  » f dJ '€ Dwn
e e Lo Y =P >
Yy Callouts ’ Rl L p
) < | OnT
(L More AutoShapes. ., Coda
Agtoﬁ\qns':[ =
e Sv Lnes »
:3} Coormatons ’
av knes ’ W0 paskswpes
£ e ' a=] Copractors ’ W Block Arrows » 5
.'.:J Cogrmetons . EO Basic Shapes ’ & Powchart .}_ —"
G odom 2 W Bockfrows b O0<
B sigpes s 6 £ Imnibee ) OO S
T Eowtet | M “ 39 s 'leoau
B i i ] CEETET PR —— o oAt
J B A Aegoshspes + lo ©
S 20 HOOO0 - 2 ' e @D L 6
Apsuper 70 Yaygoshapes | 0 15 0 AV
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The attributes you can change include the
following:

o The fill color inside the object.
o The color, thickness, and style of the border around the

object.
o The shadow effect behind the object.
oThe three-dimensional aspect, or perspective, from

which you are observing the object.
o The angle of rotation, or orientation, of the object.
o The alignment of the object in relation to the page.
o The way text wraps around the object.
o The order of the object in a stack of objects.

‘ BEFORE YOU START Autoshapes ~ l

(' Going to open new document.
|

To insert autoshapes :

. . [rsert
1 Click on insert menu. S
2 Click on picture. P g Myriers...
3 Click on Autoshapes - Date and Te...
4 Click Autoshapes from draw. "=
£ ties : | pture vl @ geat.
%o] Copnectors ’ Text Box * [& FEromFie... ‘
D tmrem & oo G ai |
T Block iyrows ’ ¥ 1Al worda...
E’g Elowchart » n Chart
R StarsadBanners » v am— 0k . S—
B class ' é::ﬂ?o'éic&%i;‘
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1 Click on the page roughly where you want your word
art text will appear.
2 Click on Autoshapes from draw bar.

| v ti |asoons- . NFCRBAC IR S LA T
:J : 3 4 3 Click on basic shape from
Cogrecions
O Ig Autoshapes menu .
|2 e Weams f & 4 click smiley face .
‘- 2oy ord Sorners » _,; ﬁl El ﬁ
‘l@odn
Ceadim
™ 04 S
S—t— wn
..'n‘ ' -

«T8atle your '.1'.1'.'.1": nere

T ewels




i

A SAV

workshee? /
Inserting wordart o
Inserting outoshopes Q/

Open a new document.

Type your name .

Select your name and click on center button
from formatting tool bar.

Press enter.

Click insert menu from menu bar.
C lick on picture.
Click on word art.

Type your school’s name.

Click insert menu from menu bar.
C lick on picture.

Click on autoshapes .

Click on smiley face

Draw the document .
before you save .

Save your work .

Close your file, Exit word .
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Using tables

Objectives
y the end of this chapter, you will be able to:
® Present information in a table.

® Format table information.
® Work with table data.
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Inserting Tables into a Word Document:

To insert a table into your document, go to Table
menu and select Insert. It will ask you to specify

the number of columns and rows.
Table skee

tumber of cokimns: N
—

Number of rows:

Example of Table inserted into document given below:
You are now ready to start entering text into the table.

Inserting Rows into a Table,
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Add a table:

Table provide an ideal structure for organizing and
presenting information. Table data can be sorted
alphabetically, numerically, or by data, and you can
treat the table like a mini-spreadsheet and use it to
perform calculations. Word lets you move the table
around the page, or position it exactly where you want
within text.

BEFORE YOU START D

{' Open new document.

- Think about how man

- arelikely to need .
|

Y columns and rows you

You can insert a table in your document in "” -
| various ways:
| Use the Table menu from menu bar.
2 Click on Insert command.
3 Choose either the Table.

1
J Dray Table
[ et 2 -'!l: Table... 3 ]
Or e ,
sebegt ’ |

Click the Insert Table
button on the standard
toolbar.
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Table consist of :

Put the cursor where you would like to insert the table.

Open a new document, and Insert table
as below this table consist of 2 columns

and 6row .

Name of shape

Number of side

Circle

Trional

Square

Pentagon

Hexagon

1
3
4
5
6




ey

3:]:::::;5‘9:! a table in your document in JI‘S ‘ "’i"'lﬂ
| Use the Table menu from menu bar.
2 Click on Insert command.

3 Choose either the Table .

1w
F Cram Table ] 2
| lrsert 2 N =™ S
Delete » S
Selogt »
M Table AutoFormat |
¥
| —
Table see
Number of columns: 3 —
- I oK I Cancel
humber of rovs: 2 o
4 Change Number of columns to be 2 ==
using mouse to change value . X
5 Change Number of rows to be 6 S
using mouse to change value - ~L

ul Document - Microsoft Word

Be £t Yew et Fomx Jooks Table Window e Adobe FOF
Acyobat Comments

x
DEEd=2 & B o- ) %% -+ 2%
-2 MR 7y FlEamiziE 2-A-2

" ~ 1 (R CEETREY" IRRTRRR P S R [SERTEEE O ﬂl
Column

CO.L;_

. v
Draw= 13 Autoshepes = OOCEHB AR E >-£2-7
Page 1 Sec { i ~ Lt n1 Col 1
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(111118
o
5

=

| 3] |

Format table information:

table
button the size of the table .

Using the table resize handle to change

PANNCOOHEADTE &L

Table
resize
handle

wl
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. "'"fg y 3 ) “ S 1
Click on Ly P— w— \
select table o v \
- i I
button = |
sl \
|

Change the look of the tex

Click on font from formatting bar,
and change font to be “Time New
Roman".

Click on font size from the
formatting bar, and the change size »
tobe 24. -

P

Times NewRoman « 29 «

. o'(u‘-.'." G 1 ' ' 3 | R [} 13 | 3

- —

2

i

B

s

L2

Namber of Shape Namber of

ESaesssssesees——e—"———C

o b

'_‘ S ———————

: Imanzle 3

: L

: |

4 z

- I

x O

-
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28 Document? - Microsoft Word

Ele Edt Yew [nsert Format  Jools Table Window Heb  Adobe POF

Page 1 Sec 1 151 At 2.5° Iné Coll

Acrobat Comments x

Do & B - 3= gn -HETWELR

TmesNewRoman = 12 - B 7 U EE|=E W ® |SiZ FiF -4
-

PREEE R ST SRR RS PEPEPREP SRCT SRR SRR - R

: Subjects Jan Feb Mar

: Computer 10 12 20

- Math 55 45 1)

l Enghsh 25 30 20 -
-~ | 2
z )
- B .
= ome ¢ i

oaw> (3 agoshawes N W CJOE Bl 440 - L-A-=
F Engi
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Using Autoformat table:

Objectives
By the end of this chapter, you will be able to:

® Add autoformat tables.
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Autoformat table :

This option is used when you want to create a certain
design for your table. Many different styles of tables
are available ranging from standard layout grids to
3D grids. Highlight the table that you want to format.
Go to Table menu and select Autoformat. You will
see a category of format as the folowing.

Jan Feb Mar Total
East 7 7 N 19
West |6 4 7 17
South |8 7 9 24
Total 21 18 21 60

Jan Feb Mar  Tortal

East 7 7 5 19
West 6 4 7 17
South 8 7 9 24

Total 21 18 21 60

Jan Feb Mar Total
FEast 7 7 5 19
Pest & 4 7 17

South 2 1 ? 24
Total 21 13 21 60




Table autoformat :

BEFORE YOU START

e e—

To use table autoformat :
- Go to the Table menu.

- Choose table autoformat,

To use the table autoformat.
To do this write this table :

Subjects Jan ok

Computer 10 o
Math - -

English 2 -

&y

A SAV !
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=@l 4|

#age 1 Sec | 1 A 25

<3 Dacumentl - Microsaft Word

Blo B Yow [t Fomal  Jock Tee  Windoe Heb  Adohe POF

Acrobat Commerts »

Neds & [ 3 T ue 3P AN

TmechmeRoman = 12 « B 2 U [FlEam SiswFE 2.4 7

- .w......l.”..”z..‘...A,”.....‘.‘.,‘.A,. o A T‘

D Subects _ [Jan Feb M

S Computer | 1U 12 U

- Math 5% 4% 60

: .Ig_xghsh f23 30 20 =~

. z

':u -
=

O~ [} Agoshepes~ . NCJO B M AR >-Z-A-8 727

tne  Col | Engh

- Click on table from the main
menu.
- Click on “autoformat table”,

S Drag Table

Treert N
Delete ’
Select ’ |
Table AROEOmE... |

| ¥ J

Table style :
The name of the table style.
You can choose one.

Preview : To see the result ,

Apply special format to : To
change format of table style

- Heading.
- First column.
- Last row.
- Last column,
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Errre— Click on the name of style

> . Look at the preview.

Drow> 3 AoSwpess N WJOE 4R L4 7
Page 1 Sec ! if A28 In5 Cd1 g
e —————-
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Finding and Replacing Text:

Objectives
By the end of this chapter, you will be able to:

Find text in document.
Replace text in document.




i

nSA I FFinding and Replacing

When editing your work, you may realize that
you have consistently misspelt a name or used
the wrong sort of formatting and character.
Word’s find and replace feature allows you to
correct those errors with just a few keystrokes.

To find the text in a document-
To find and replace text in a document.

I Open “Edit” menu from main menu.
2 Select *“find” or “replace™ -

'm jL B
1 Urdo Tyong Qi O rdoForc Soe Seec:. Qa2
O epex yong  Crisf | 0% Snd Growmy Conge CaliY
B 0Fie Clppcerd.. B o Opigad..
B et Qrad R o ik
Pacts Spec...
Fate Jeca
Pate x el
Oey » i
seatAl  Crid Cey '
M e arwe oot 4 Qi
| epbes..  oben | !ﬂpu. e
wlo.. ks | Agam. CriM
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Type this text:

To add a picture watermark

1 In the lower-left corner of the window, click the Print
Layout View button.

2 On the Format menu, point to Background, and click
Printed Watermark.

3 Select the Picture watermark option, and then click the
Select Picture button.

4 Double click the picture you want to insert as a
watermark.

5 Click the down arrow to the right of the Scale box, and
then choose how big

or small you want the watermark picture to appear in the
document.

6 For a more vibrant picture, clear the Washout check
box.

7 Clicks OK.
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& Fon o mory vibennt pirturs, e the Washas shred bos

VI@rm oW # g bogn e @i sy

TG OK
- Save
-+ _document
:.l ..-'u i -u- Wi s e - 3 [

1- Click on edit menu from main menu.
2- Click on “Find.”.

i

ol e | e

UndoFont Sae Seect  Ctri+l
O« RedoGrommar Change  Ctritr

52T

“Picture *
ick Find next.

Toadd --vu-una.

1 I the Jower- Joft coenes of the wincow, ciick the Priet Layout View huttos
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- Click on * Find nex

1 TS b gt W g S Do ey, e e e ey
- -
:ho.-‘-'— —,.‘

Pde et —

LR

- Click on ** find next™-
- Mark the check box-

N Highlight o1 tems found in:

e

-Click on “Find gext™

K - Microsolt Word X
e & Yew Jue we ook Tgbe Whdow ek howe to g ek . %
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Write on find what: R T - .
“wD: .- CoRau AT Avm vn AR Es - a1
Plcture .-0“ -.—.--.cn.e. - T S ;

- “l.-oto----...".’.-' ‘1

Write on replace with:
“Image”
Click on replace.

R

e
'b.h— s B ket ol So et et S b

- —
N Sk s v - — - S —

——.z—.—-..u_
£1 . - — " - ——

Click on replace.

oo |[yhe ] sang |
crasaft Word X ‘

| Wordhas rzachad e end of ife docrere, 3rapacsmertswerzmade. 0oy
\/ Wit o ootorue surcheg o the begnng!

o |
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worksheet A
Find and replace &
Open a new document.

Type the following :

She sells sea shells on the sea shore.

Find the first “sea” and replace it with the word “crab by
Click on replace.”

Replace the second “sea “with the word *“lake™

Save your work as the ‘
following name “findword”

Close your file, Exit word
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er & footer

tives
nd of this chapter, you will be able to:

Add header to a document.
Add footer to a document.



Headers and footers:

Header and footer enable you to add running
information to your pages, such as page numbers.
They appear at the top or bottom margins of your
document, outside the normal print area. Any thing
that you insert in a header or footer appears on
every page of your document, unless you specify
otherwise.

BEFORE YOU START

o ——

To ac!d a header or footer
the view menu and choos

toolbar appears that
: allo
style it as you wish.

toa document, click on
e header and footer, A
WS you to enter text and

To add header and footer :

| Click on view menu from main menu-
2 Click on ** header and footer” .
m-wl — -

Show Paragraph Marks

Grichines
[ tpader and Footer 2]
Z0om...
¥
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h 08 e et fyea e Moh e 36 Ak

Seunue m-- cem .za-e. Word switches to Print
e jucaraBmampres2-a: 3 Layout view, outlines the
. - L A | -ﬂ

header area at the top of
the page, positions the
insertion point in the
| header, and displays the
| Header and Footer
;| toolbar.

. (N
e L Aptemc - A DICHNAECED Do gl
' N v ) e

123 45678 9101

Insert Page Number.
Insert Number of pages.
Format page number.
Insert date.

Insert time.

Page set up.

Show/hide document text.
Same as Previous.

Switch between Header and Footer.
10 Show Previous.

|1 Show next.

O 00 ~1 W B W)



Click on view from menu bar. s
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J[\\ “’U “] Click on view from menu bar.
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Formatting Page Numbers

When you insert page numbers in headers or footers, you
can format them directly using buttons on the Formatting
toolbar as long as the header and footer areas are active. If
you want to change the formatting later you can change it
by clicking on Page Numbers on the Insert menu and
making changes in the Page Numbers dialog box. To format

existing page numbers: o
I On the Insert menu, click on Page Numbers. ™ - -
The Page Numbers dialog box appears. | i |

Dalw wel Do
Boo.,

2- Click on the Format button.
The Page Number Format dialog box appears.

3- Click on the down arrow to the right | ae e o —

of the Number Format box, and click |~ wssaewsms -

on the number format you want. e

4- Select any other qptions you want |"y2e=s —

to apply, and then click on “OK", Chme [ B
) o

5- Click on the down arrow to the right of the Position box, and
click the location where you want the page numbers to
appear.

6- Click on the down arrow to the right of the alignment box,
and click the alignment setting you want.

7-Click on “OK" to close the Page Numbers dialog box .




worksheet %\
Header and Footer X/
Open a document“findword”.

From view menu select Header ant_l foqtcr
Write the text “Good school” "
in left part of the header area
Go to the footer area

Click on page number button
From Header and footer tool
bar .

hidan? i p—— o u—

. o
. .
. .
i frrsannnant

Select number of page from
footer area ,

Go to formatting tool bar and
click on center button

Save your work.

Close your file, Exit word .
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rinting a Document

Objectives
By the end of this chapter, you will be able to

® Preview a document
® Print a document.
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When you are satisfied with the way a
document looks in Print Preview, you can print it by
clicking the Print button on the Standard toolbar or
on the Print Preview toolbar. Word then uses the
settings specified in the Print dialog box and your
computer’s default printer.

To view or change the print settings, click
Print on the File menu to open the Print dialog box.
You can then specify which printer to use, what to
print, and how many copies, and make other
changes to the settings. In this exercise, you will
preview a document, adjust the top margin, change
the orientation, and select a new printer before
sending the document to be printed.

Before printing a documents, you should
verify that it looks the way you want. Office
Specialist save time, money, and paper by avoiding
duplicate printing.

Print Preview shows you exactly how your
text will be printed on each page. This is essential
for multi-page documents, but is helpful even for
one-page documents. The Print Preview toolbar
provides the tools that you need to check the
presentation of each page. You can see the layout,
and you can even change the text from this view.

The way a page is laid out in a printed
document is called the page orientation.
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You are now ready to print out your pages. For
the best results, take time to consider the
appropriate layout for your document and to
view how it will look before printing. Most
printers allow you to vary the size of paper you
printer, you may even be able to produce high

quality photographic prints. &

BEFORE YOU START é

Open the word doc
Go to the file menu and sele

To start printing or preview printing :
|

| Click on * file menu” from main menu.

2 Click on print or print preview . bl

Or b Qen.,.

3From stranded bar click on “print icon™ Q ::
From stranded bar click on “print preview i

icon”, -
3 g =
& Web Page Peview
Page Sehp...
[ Print Preyiew

g Print preview 8 bi..

Print




> =

'\ 3 : . .
NSAV R | Clickon file from menu bar. > o
2 Click on print preview from file menu, ..
n Lew ot
Tneds
| Ve et Pagn
}u el
s T Preves
=4 You can print elopes.doc (Preview) - Micrasalt
o...MarginTop
Portrait
orientation

A document has only one page orientation
unless you divide your document into
sections. Then each section can have its own
page orientation .
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1 Print
3 One page
4 Multiple
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6 View ruler 7 Shrink to fit
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8 Full screen ‘i
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If you want to use the current Print dialog box settings,
you can click on the Print button on either the Print
Preview or Standard toolbar to print the document
without first viewing the settings.

If you have more than one printer available to you and
you want to switch printers, click on the down arrow to
the right of the Name box, and click on the printer you
want in the drop-down list.

In the Page Range area, click on the Current Page option.

In the Copies area, change the Number of copies setting
to 2, and thenclick on OK.

Word prints two copies of the first page of the document
on the printer you have designated.
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worksheet

Printing a document 7
&

Open a new document .

Type your name.
press on enter .

Now type a list of things that you would like for your birthday.
press enter after each item.

- In my birthday | Iike— _

Save your work .
print two copies of your
birthday list. '

Click on the arrows to change '
the number of copies to .
2birthday list. !
Do this task again but use the .
icon on the top of the screen .

Close your file, Exit word .



o

RS Woril

worksheet /

Printing Printing preview ——
a document &/

Open a new document .

Type your first name and surname.

Press on enter.
———

r class name or numb r.>— N '
Type your class name umbe " My first mamne i - |
Change the font. ,' "

Change the font size to 72. | ‘.
print preview your work . 3' My surname R »'

|

If your name is too big to fit on |: i
one line, close. ' ;
! |

Change the font size to 48 ; ;

e — |

Print your work

Do this task again but use the icon on the top of the screen

Close your file, Exit word .

\
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sing borders:
Objectives
By the end of this chapter, you will be Able to

® Add a border to text.
® Add a border to page.

ART AT AT AT A AT ads

]

TR ARR

BERRTRARANRARRRATRRRRIRR

AT A d

VP99 00099
LA A ddadaad d gl ]l

l'




You can enhance the appearance of a paragraph by
changing the way text is aligned, Office Specialist
modifying the spacing between paragraphs, and
adding borders and shading around text. In Word, a
paragraph is any amount of text that ends when you
press the Enter key. A paragraph can include a single
sentence consisting of one or more words, or several
sentences.

You control the width of paragraphs by setting the
left and right margins, and you control the length of
pages by setting the top and bottom margins. The
margin size controls the amount of white space that
surrounds your text. You can use the options in the
Page Setup dialog box to control the margins of the
entire document and of specific sections of the
document.

Welcom
R e B 8 Ty ecat % S S et s Gala it e e e 3
- - Welcome Bl
; Welcome
-
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Adding border to text:

BEFORE YOU START

| Go to the format menu.
- Choose border and shading

Write this text:

Member of the art club :

Marim Hossam Mohamed Anwer.
Hessan Mohamed El gabry

Nora Mohamed El gabry.

May Samir Mahdy

Mohamed Samir Mahdy.

Mustafa Samir Mahdy.
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Select text:
Members of the art club:
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fordens and Shading e.nwh.

Bullets and Numbering., ..
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Borders | r
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A Eont.
-Click on format menu. 5 pasysh.
-Click on Border and Shading. := sdesadtnbeing..
| forders and Shadeg. .
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Ark:

Click on the art menu. ’ o LII

Select one. |
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—
Border text 2/
Border page
Open a new document ,
Write your name .
Insert your picture , . COoRunny | —

IBAAAAAAAAAAAATTRY |

i

Select your name , g
Click on font size and select 72 _

From format menu select
Border and shading ,

Select * border tab” -

From format menu select .
Border and shading .

¥

¥

¥

Y

¥

N

y

| ¥

| Y

| Y

| ¥

Y

M

A

v

A

A
Select * border page tab™ . . v
'

v
Y
Y
¥
M
¥
¥
v
M
M
M
¥
¥
A
‘
A
A
'
M
v
M
v

Save your work . 2 Rsosssissamistased

Close your file, Exit word .

'Wl‘i'l’eS‘teps)””“”.”“”E
N :
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Page layout

Objectives
By the end of this chapter, you will be able to

@ Change between two orientations
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S Woril Orientation of document:

The margins are set to default values. To selecta
new value, click on the up or down arrows beside
each panel, or highlight the existing value and
type a new number . Under “orientation”, select
portrait (vertical) or landscape (horizontal).

BEFORE YOU START

—

' Go to file menu and select page setup.

To open the dialogue box of page setup
Do this :

-
Click on file menu. N e o
Click on page setup. & 0. o0
=

Mughn | Pager | Loyt | Donismeet Gl | ;
g = R s
o 5 'EI [ |l' ) M.,
G @ 3 omw pemen [t %) § swzwbrge
Ovierdativns u S,

[E‘I] E e Page Pozum

e s — P e
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Setting -up a landscape page =

Open a new document,

set-up a landscape page.

Click on font and select Arial, I
Click on font size and select 72, A

Type the name of your favorites pop star.

Press on enter .

Change the font size to 28 . Aj

write three sentences about why

you like them. Landscape
check your work in print, '
12 -
Save vour work . \
y ‘ F = = = = »

g Times New Roman  ~
Print your work.

Close your file, Exit word. .

fe—— ‘ -.:..--..

Select o .

Write
File
page set up
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Using help:

Objectives
By the end of this chapter, you will be able to

® Get help
® Use help
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If your question is about Microsoft Office Word, and not about
the content of this Microsoft Press book, your first recourse is
Word’s Help system. This system is a combination of help
tools and files stored on your computer when you installed The
Microsoft Office System and, if your computer is connected to
the Internet, help files available from Microsoft Office Online.

To find out about different items on the screen, you can display
a Screen Tip. To display a Screen Tip for a toolbar button, for
example, point to the button without clicking it. Its Screen Tip
appears, telling you its name. In some dialogue boxes, you can
click a question mark icon to the left of the Close button in the
title bar to display the Microsoft Office Word Help window
with information related to the dialogue box. When you have a
question about using Word, you can type it in the “Type a
question for help” box at the right end of the program
window’s menu bar. Then press F to display a list of Help
topics from which you can select the one that most closely
relates to your question. Another way to get help is to display
the Office Assistant, which provides help as you work in the
form of helpful information or a tip. If the Office Assistant is
hidden when a tip is available, a light bulb appears. Clicking on
the light bulb displays the tip, and provides other options.
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Getting Help: JES Worl

If you need help with word or would like the
friendly office assistant to help with a specific
task, then select the option you want from this
menu, including help an the web.

BEFORE YOU START @

BE SURE TO sta T
exercise, "t Word before beginning this

1 At the right end of
the m :
Type a question for help boi?u bar, click on the

To begin, open Microsoft Word. Your
screen will look like the one shown [

| Open the start me
2 Select “All programs™.
3 Select “Microsoft.

A Decument! - Micresoft Word

fe GO Yew jost Fymx Jock Tibe whde tep _q_.]x
Ceg &R D fwsshenPoum 12 o l[nii |51 E g
SRR 1 T oedoid g g7 g o] 88 RewDocument vx
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| Type How do T get help?

R
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list of topics that relate to your Rptvind
lestion appears in the Search R o SO
esults task pane.  howto ot ek . il
© Troubleshoot Help ——
it ¥ ~ You can click any

© Guidelres For

searching Hep
© About Miarosolt

techrical
resources

© Add Help text to
a form

W Sea more. .,

of the help topics
to get more
information or

*_instructions.

A\
l'.

the Search Results task pane, scroll down the results list,
and click on About getting help while you work.
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At the right end of the Microsoft Office Word Help Q

window's title bar, click on the Maximize button, and

thenclick onthe Show All option.

The topic content expands to provide in-dept information
about getting help while you work.

.
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Click on the Microsoft word,
help from stander bar,

2
[3

Microsoft Word Heb

Vlha would you like to do? |
Mcrosoft Word Hobl
L Qptions Search

Right click on Microsoft word help icon,
Click on hide from menu.

Click on help menu, e

Click on Hide the office assistant. |5 mocscr wordteb  #1
Wids the Office Assistant |

K2 whatsThis?  shift+F]
QOffice on the Web
Activate Produdt. ..

About Microsoft ‘Word
3

Right click on Microsoft word help icon,

Click on option from menu. —
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@ e e e Amtae
P oot @ fL Wy Py P
- - G vt
* Gurer sy - e pren

¥ g bets e vy Wty oty show bl srardy tom
¥ e e e e e T (BN T A 2 e
T pwtced dernes [op——




Referances

I- Maggie Banks & others, GCSE Applied ICT, Folens Limited - 2003,

2- Dr. Richard Clark, Basic Concepts of LT.. University of London - Not mentioned
3- by Dan Gookin, Buying a Computer For Dummies , Wiley Publishing, Inc. - 2006 |
4- Andrew S. Tanenbaum, Computer Networks, Prentice Hall - 2003 .

5- William S. Davis & others, The information system Consultant's Handbook , CRC
Press - 1999 ,

6- Drew Bird, A+ Certification, Faster Smarter , Microsoft Press - 2003,

7- Ron White, How Computers Work, QUE - 1998,

8- H.L. Capron, Computers tools for an information age , Prentice Hall - 2004 ,

9- Peter Norton, Computing Fundamentals , McGrawHill - 2003,

10- Not mentioned ., Basic Computing Using Windows ., Wikibooks - 2006 ,

11- Kristine Haugseth & others, Windows XP inside out, Microsoft Press - 2005,

12- Alan Simpson, Alan Simpson's Windows XP Bible , Hungry Minds, Inc. - 2001,
13- Andy Rathbone, Windows XP For Dummies® , HUNGRY MINDS, INC. - 2001,
14- Not mentioned, Windows XP Student Edition, CustomGuide.com - 2002 |

15- Department of Media and Technology, Beginning Microsoft Word 2000, Joanne
K. Davis - 2000,

16- Various authors, Microsoft Office 2003 Super Bible eBook , Wiley Publishing, Inc
-2003 ,

17- Katherine Murray, Microsoft Office 2007 system. Microsoft Press - 2006 ,
18- Sarah Fowlie, Word 2003 in pictures, In pictures - Not mentioned |
19- Brent Heslop & others, Word 2003 Bible, Wiley Publishing, Inc - 2003,

20- Mary Millhollon & others, Microsoft Office Word 2003 Inside Out, Microsoft
Press - 2004,

21- Greg Perry, Microsoft Office 2003 in 24 hours, Sams Publishing - 2004 ,
22- Alex Blanton , Mjcrosoft Office Word 2003 step by step, Microsoft Press - 2003,
23- Jean Hollis Weber, Taming Microsoft Word 2002, Jean Hollis Weber - 2002,




& iall Cilaslgell




